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A - Introduction

Meets the requirements of the following applicable European directives and carries the CE marking accordingly:

• Low Voltage Directive 2014/35

• Electromagnetic Compatibility – Directive 2014/30/EU

• Restriction of the Use of certain Hazardous Substances in Electrical and Electronic Equipment (RoHS) 

       – Directive 2011/65/EU

Meets the requirements of the following applicable UK directives and carries the UKCA marking accordingly:

• Electrical Equipment (Safety) Regulations 2016

• Electromagnetic Compatibility Regulations 2016

• The Restriction of the Use of Certain Hazardous Substances in Electrical and Electronic Equipment Regulations 2012

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device 

may not cause harmful interference, and (2) this device must accept any interference received, including interference 

that may cause undesired operation. This equipment has been tested and found to comply with the limits for a Class A 

digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 

harmful interference when the equipment is operated in a commercial environment.  This equipment generates, uses and 

can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause 

harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 

interference in which case the user will be required to correct the interference at his own expense.

1.2. Concept & Control Options

Mini-Circuits’ eVNA concept is a system formed from 3 elements, all of which are required 

for VNA functionality:

1. Host PC with Microsoft Windows

2. eVNA-63+ hardware connected by USB to the host PC

3. eVNA Studio software package running on the host PC
Mini-Circuits’ eVNA-63+ is a high performance, software-controlled vector network analyzer 

(VNA). By moving the complex data processing and calculation required of vector network 

measurements out of the instrument and into an advanced software package, Mini-Circuits is 

able to offer a fully-featured but cost effective VNA for every test bench.

The product ships with Mini-Circuits’ eVNA Studio software package, providing a powerful GUI 

which will feel familiar to any engineer with experience of VNA measurements.

1.1. Key Features

• Time domain analysis & gating

• Full 2-port, 2-path s-parameter measurement (S11, S21, S12, S22) in a variety of formats

• Complete vector network analysis capability

• Application programming interface (API) for measurement automation

• Robust SCPI command interface (compatible with legacy VNA models)

• Touchstone file support (import & export) for use with Electronic Design 

     Automation (EDA) simulation tools

• Offline simulation mode for measurement preparation, training and analysis 

     of s-parameter data with no hardware present

• Port extension / de-embedding

• Internal bias-tees for powering of active DUT (devices under test) 

  eVNA-63+ USER GUIDE — A - INTRODUCTION   |   

Label Meaning
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  1211

VNAs are precision test instruments, based on relative measurements made between 

the internal source and receivers. To achieve the specified accuracy, careful thought must 

be given to the complete measurement process, from understanding the features / limitations 

of the instrument, to the hardware connections, to calibration and instrument settings, 

to data interpretation.

This user guide is intended for test engineers of any level of experience who intend 

to perform RF measurements on 1 or 2 port devices with Mini-Circuits’ eVNA-63+.  

It outlines the specific instructions for software installation, hardware setup, VNA calibration 

and error correction, and provides recommendations on best practice for RF measurements.  

It is recommended that the user familiarize themselves with all aspects of this guide before 

starting measurements.

The core sections of this guide are structured into Mini-Circuits’ measurement 

philosophy, as defined below:

1. Prepare

• Familiarize yourself with RF and measurement basics and best practices

• Setup and understand the eVNA Studio software

• Review any applicable reference material to support the measurement

2. Practice

• Use appropriate, high quality and well-maintained accessories 

• Define the measurement goals and requirements

• Trial connections and instrument settings to ensure all needed components 

    and accessories are readily available

3. Calibrate

• Inspect the test environment and take steps to minimize sources of random error

• Select and examine calibration standards, ensuring they are clean, high quality and  

free of damage

• Consider systematic measurement error sources and perform a careful calibration

4. Measure

• Configure the eVNA Studio software settings

• Perform the measurement

• Understand the results

2. About this Guide – Prepare, 
Practice, Calibrate & Measure

2.1. Measurement Automation / Programming with SCPI

This guide focuses on VNA measurements using the Graphical User Interface (GUI) 

of the eVNA Studio software package. The software also includes an Application 

Programming Interface (API) which allows automation of all eVNA features from most 

common programming environments, including Python, LabVIEW, C# and many more.  

The process involves creating a raw socket connection, either within the host PC or from 

a remote PC across a TCP / IP network, and sending a series of standard SCPI commands 

for control of the eVNA.

Where possible, this guide also includes a summary of the SCPI sequence used to achieve the 

particular action being described in the GUI. SCPI sequences will be presented at the end of 

relevant section in the format below:

Full instructions for programming with the eVNA-63+, including how to implement the SCPI 

commands, are covered in the programming manual available from our website at:

minicircuits.com

SCPI

SENSe:FREQuency:STARt 500000

SENSe:FREQuency:STOP 6000000000

SENSe:SWEep:POINts 201

|   eVNA-63+ USER GUIDE — A - INTRODUCTION   eVNA-63+ USER GUIDE — A - INTRODUCTION   |   

2.2. Terminology

For clarity, the following general terms are used throughout our documentation to refer 

to VNA concepts and the specifics of Mini-Circuits’ eVNA implementation.

VNA A reference to Vector Network Analyzer test equipment in general, as available from a range of manufacturers.

eVNA Mini-Circuits’ family of VNA products, including hardware and software elements.

eVNA-63+ Mini-Circuits’ eVNA-63+ model, operating over 300 kHz to 6 GHz.

eVNA Studio The advanced software package required for operation of Mini-Circuits’ eVNA family, including a GUI & API.

Host PC The local PC connected by USB to the eVNA-63+ hardware and running the eVNA Studio software.

Remote PC A second PC, attached to the same network as the host PC and capable of remotely operating the eVNA via the API.

Term Intended Meaning

2.3. Languages

Please contact testsolutions@minicircuits.com if instructions are required in other languages.
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3. Support Contacts
We are here to support you every step of the way. For technical support and assistance, please 

contact us at the email address below or refer to our website for your local support:

testsolutions@minicircuits.com

minicircuits.com/contact/worldwide_tech_support.html

B - Prepare

The eVNA-63+ instrument and external AC / DC power adapter module contain no user 

serviceable parts and should not be opened. Discontinue use and contact Mini-Circuits

in the event of visible damage to any parts.

1. Safety & Cautions

Caution: 
• Only use the AC / DC power supply adapter supplied with the instrument.

• The AC plug acts as the mains disconnect for the equipment. The user should ensure the equipment 

is positioned so that the AC and DC plugs are not obstructed in the event the user needs to remove 

power from the equipment.

Caution:
• Observe ESD precautions when handling and connecting the eVNA-63+ to avoid damage.

1.1. Maximum Input Levels

Adhere to the published maximum specifications on all ports as stated 

in the published datasheet.

1.2. Bias Tee Output Levels

The internal bias-tees on Port 1 & 2 allow a DC bias to be passed to components within the test 

path as required. The DC voltage current / output is determined by the external source input 

connected at the Bias 1 & 2 ports. Be sure to check that the DC bias output is within the safe 

limits of any external devices connected within the RF signal path. 

Port 1 & 2
Input Power (below 10 MHz)

Input Power (10 MHz to 6 GHz)

DC Input Voltage

+15 dBm max per port

+20 dBm max per port

±30 V max per port

Bias 1 & 2
DC Input Voltage

DC Input Current

±30 V max per port

200 mA max per port

Trigger In DC Input Voltage 5V Max

Ref In Nominal Impedance 50Ω

DC Input
DC Supply Voltage to eVNA-63+

DC Supply Current to eVNA-63+

5.25 V max

3A max

AC Input AC Input Voltage to AC / DC power adapter 100-240V

Ports Parameter Specification Limit

|   eVNA-63+ USER GUIDE — A - INTRODUCTION   eVNA-63+ USER GUIDE — B - PREPARE   |   

4. Warranty & RMA Returns
Mini-Circuits provides a 3-year warranty with all eVNA-63+ systems.  Please contact your 

account manager or refer to our website for full details: 

minicircuits.com/support/ordering.html

If you have any questions or concerns with your eVNA-63+, please contact us in the first 

instance through testsolutions@minicircuits.com. Our team will work with you promptly to 

understand and resolve any issues. As a software-controlled instrument, it is usually possible 

to resolve issues remotely without requiring the unit to be returned to the factory.

In the event that a return to the factory is necessary, Mini-Circuits will provide an RMA number 

and full return instructions.

5. End of Life
Please contact testsolutions@minicircuits.com to review environmentally friendly 

end of life disposal options.
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1.3. Operating Environment

The eVNA-63+ is intended for testing of RF components in indoor laboratory or production test 

environments. Do not use in damp or excessively humid conditions, or in any other condition 

which exceeds the published environmental specifications.

1.4. User Service / Cleaning

The only user-performed service possible for eVNA models is external cleaning of the case and 

connectors as needed. Do not use any detergents or spray cleaning solutions. The case can be 

cleaned with a soft, slightly dampened cloth and the connectors with an alcohol solution. Do 

not allow any liquid ingress into the case or connectors.

2.1. Standard Factory Cal - Lowest-cost

Place your calibration order with any Mini-Circuits sales office, or authorized representative / 

distributor and ship the unit back to Mini-Circuits with the details provided. Mini-Circuits will 

calibrate and return the unit, accompanied by the calibration data and certificate.

3.1. Software Downloads & Resources

The full eVNA Studio software package including GUI and API is available for download from:

minicircuits.com/softwaredownload/evna.html

3.2. System Requirements

The minimum requirements for installation of the eVNA software package and API 

on the host PC are:

• Microsoft Windows 7 or 10 (64-bit)

• Intel i3 processor or equivalent

• 8 GB RAM

• USB 2.0 or later

3.3. eVNA Studio Software Installation

1. Download the eVNA Studio software package from:

 minicircuits.com/softwaredownload/evna.html

2. Run the eVNA_x.x.x_Setup.exe installation program.

3. If Microsoft Defender SmartScreen provides a warning about an  

     unrecognized app, select “More Info” and then “Run Anyway”.

4. If prompted by Windows User Account Control, enter the  

     username and password for an account with permission  

     to install software on the PC.

Operating Temperature +5 to +50°C

Storage Temperature -35 to +75°C

Relative Humidity 5% to 85% (non-condensing)

Pollution Degree 1 - No pollution or only dry, non-conductive pollution

Altitude 2000 m

Condition Specification

As a precision test instrument, regular factory calibration is necessary to ensure continued 

operation within the published specifications. The recommended calibration period is annually.

Mini-Circuits offers 2 approaches to factory calibration, intended to provide a flexible choice 

based on your budget and test requirements:

2. Factory Calibration

3. Software Setup

|   eVNA-63+ USER GUIDE — B - PREPARE   eVNA-63+ USER GUIDE — B - PREPARE   |   

Caution: 
• It is recommended to disable the bias-tee outputs when not required in the test application in 

order to avoid inadvertent damage to external components in the RF signal path.

• The bias-tee outputs should be disabled during calibration.

2.2. Premium Factory Cal - Zero Down-time

After receiving your calibration order, Mini-Circuits will send a fully calibrated replacement 

unit to your door for use while your own unit is returned. Simply replace your own unit in the 

same packaging and ship back to Mini-Circuits. Mini-Circuits will calibrate and return your unit, 

accompanied by the calibration data and certificate. The loan unit can then be returned to 

Mini-Circuits, again using the same packaging.
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5. The InstallShield Wizard will load, followed by a Windows Security prompt 

     asking for permission to install the software.

7. Click Install to confirm the installation of “Microsoft Visual C++ 2015 

    Redistributable Package”.

8. A notification may appear to advise that the “Microsoft Visual C++ 2015 Redistributable   

    Package” installation has failed, this is likely due to a different version of the package    

    already existing on the PC. It is recommended to proceed with the installation.

a. You may optionally select “Always trust software from Mini-Circuits” 

    to avoid similar prompts for Mini-Circuits eVNA software in future.

b. Click Install to proceed with the installation.

6. Click OK on the prompt confirming that “Microsoft Visual C++ 2015 Redistributable 

     Package” will be installed.

|   eVNA-63+ USER GUIDE — B - PREPARE   eVNA-63+ USER GUIDE — B - PREPARE   |   
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9. The InstallShield Wizard for the eVNA Studio software package will load, 

     click Next to continue.

11. Click Install to accept the default location (you may first click Browse to select 

       an alternative installation folder if preferred).

10. Accept the terms of the license agreement and click Next to continue. 12. The final screen will confirm installation of the software, click Finish to finalize.

In the event of any issues with installation, please refer to the Troubleshooting section 
of this manual, or contact testsolutions@minicircuits.com for support

|   eVNA-63+ USER GUIDE — B - PREPARE   eVNA-63+ USER GUIDE — B - PREPARE   |   
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The four buttons on the right-hand edge are always shown, from left to right they are:

1. Undo – Undo the last settings change

2. Redo – Re-apply any change in settings    

     following an “Undo”

3. Toggle Panels – Toggle the GUI  

     between showing:

a. Trace + Control Panel + Sub Panel

b. Trace + Sub Panel

c. Trace only

4. Back – Go back to previous level on the sub   

     panel (where it has previously been drilled   

     down through selections made in the Control  

     Panel or Top Menu)

     The status bar is a static read-out of the current 

     settings relevant to the latest menu section.

Figure 1: eVNA Studio GUI display 

Table 1: Summary of each main section on the eVNA Studio GUI display

The GUI is laid out as shown in figure 1, with a structure that should be familiar to users of 

legacy VNA instruments. The control panel on the right-hand side provide access to the top-

level options with a dynamic sub-panel just to the left providing the next level options based 

on the user’s input. The same set of options are also available from the main menu at the top 

of the screen, to provide an interface familiar to users of PC software. Table 1 summarizes 

each of the key elements of the GUI display highlighted in figure 1.

4. Graphical User Interface (GUI) Overview

Main Menu Standard software menu bar with drill down options for all eVNA features.

Control Panel
Control panel with buttons for all top level and second level items accessible from the Main Menu.  Provides 

the same functionality as the Main Menu in a format which should be more familiar to users of legacy VNAs.

Sub Panel
Dynamic panel of buttons which updates to show the relevant options based on the last selection f

rom the Control Panel or Main Menu.

Status Bar Read-out of the current settings for the last Control Panel / Main Menu selection

Settings Bar
Additional buttons or input fields to specify any parameters required by the Control Panel / Main 

Menu selection.

Instrument Status Series of icons indicating the general configuration / status of the eVNA.

Port Status Icons indicating which of the 2 ports is currently active as the stimulus signal.

Graph Display Central graphical display showing the measured data and graphs.

Graph Status Channel and trace parameters for the graph display.

GUI Section Description

4.1. Main Menu / Control Panel Groups

The main menu and control panel provide two different interfaces to the same set of features.  

Navigation through the 2 interface types should feel familiar to uses of Windows software and 

legacy VNA instruments respectively. The top-level groupings are:

1. Stimulus: Define frequency range or time span, power, sweep and trigger parameters.  

     The start and stop frequency, center frequency, or frequency span can be specified. 

2. Channel / Trace: Defines the number and arrangement of channels / traces on the  

     data panel

3. Response: Defines the calibration of the DUT, the measurement of the DUT to the stimulus,    

     and the set-up of the graphical display of measurement results.

4. Markers / Analysis: Defines the markers to be used in the graphic display. Markers can 

     be used for peak statistical analysis of the waveform or to mark discrete time / frequency /    

     data points.

5. System: Defines the hardware capabilities of the eVNA system, with options to save 

     and recall different data sets. 

4.2. Settings Bar & Status Bar

The Settings Bar updates dynamically to provide additional input options where required,  

for the last selection made through the Main Menu or Control Panel / Sub Panel.

The menu sequence below for example, displays an input box for “Num Traces” to allow the 

user to enter the number of active traces. The cross icon is used to cancel the input and the 

tick icon (when shown) or enter key to set the parameter.

Channel / Trace → Trace → Num Traces

Num Traces dB
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4.3. Instrument Status Icons

The instrument status bar at the bottom of the GUI, beneath the graphical display, contains 

a series of icons which are either “illuminated” or inactive to indicate the current status 

of the eVNA instrument. Table 2 summarizes the function of each GUI icon.

4.4. Graph Status Notifications

The graph status bar shows indicates some key parameters / settings for the active channel:

• Active channel number 

• Start / Stop / Center / Span frequency

• IFBW - IF bandwidth of the sweep

Table 2: Explanation of each instrument status icon

 Bias-tee
Internal bias-tee is enabled

System → More → Bias Tee

Display Updates
Updates to the graph display are enabled

Response → Display → Update

RF Output
RF output is enabled

Stimulus → Sweep Setup → Power Menu → RF Out

Measurement Status Measurement is initializing or in progress

Trigger Source
Trigger source selection (internal, external, manual or SCPI):

Stimulus → Trigger → More → Trigger Source

Reference Source
Reference source selection (internal or external)

System → More → Reference Clock Source

Temperature Status
Green (device up to temperature), yellow (device is warming up),

or red (over temperature, device will shut down)

Connection Status
eVNA-63+ instrument hardware or simulator mode is connected

System → More → Connections

Function DescriptionIcon

5. Hardware Setup

5.1. Front Panel Layout

5.2. Rear Panel Layout

Power Indicator LED

Indicates power and software connection status:

• Red = Power on but the instrument has not been claimed by the eVNA Studio software on the host 

PC

• Green = Power on and the instrument is assigned to the eVNA Studio software on the host PC 

  (ready  to measure)

Port 1 N-type female RF source / receiver test port 1

Port 1 N-type female RF source / receiver test port 2

Bias 1 BNC female DC voltage input port for bias-tee 1

Bias 2 BNC female DC voltage input port for bias-tee 2

Aux Sync BNC female Auxiliary input (not currently in use)

Trigger In BNC female External trigger input

Ref In BNC female 10 MHz reference input

Ref Out BNC female 10 MHz reference output

USB 2.0 USB type B USB control port

DC Input 2.5 mm DC socket 5V DC supply input

Type

Type

Description

Description

Item Name

Item Name

|   eVNA-63+ USER GUIDE — B - PREPARE   eVNA-63+ USER GUIDE — B - PREPARE   |   



  2625

5.3. Initial Connection & Power-On

5.4. Test Port Connections

1. Connect the USB cable between the eVNA-63+ instrument and the host PC

2. Connect the supplied AC / DC power adapter between the eVNA-63+ and a suitable AC    

     mains power source

3. The eVNA-63+ will power on as soon as the AC supply is turned on, RF measurement  

     functions can then be enabled through the software

4. It is strongly recommended to allow the unit to warm up before calibration or test   

     measurements are carried out. This takes approximately 15 minutes and the temperature  

     indicator in the eVNA Studio GUI will appear green once the instrument has reached a  

     stable temperature.

Ports 1 and 2 are the RF test ports, both with the option to be configured as either source or 

receiver. It is important to use good quality accessories and cables, properly connected and 

torqued with a suitable torque wrench. Mini-Circuits supplies a full suite of test and calibration 

accessories.

Accessory connectors should be inspected regularly for damage and discarded at the first sign 

of wear and tear. N-type connector savers are recommended in environments where frequent 

or high numbers of connections are required on ports 1 and 2. These can then be discarded 

and replaced in the event of damage, rather than requiring repair to the eVNA-63+ instrument.

Note: 

• Ensure the eVNA Studio software package is installed on the host PC before proceeding.

5.5. Bias-Tee Connections

The bias 1 and bias 2 ports accept a DC voltage from a suitable source (up to 24V, 200 mA 

on each port). The DC bias can be fed to the measurement ports, Port 1 and Port 2 to support 

testing of amplifiers and other components which draw the DC supply from the RF path. The 

DC bias output on ports 1 and 2 can be disabled or enabled together using the software:

1. Select the bias-tee feature:

    System → More → Bias-Tee

2. Check the “User bias tee function?” option and click OK to enable the DC voltage outputs

3. Repeat and uncheck the option to disable the DC voltage outputs

Caution: 

• It is important to disable the DC bias during calibration.

• Both bias-tees are enabled or disabled simultaneously, ensure that all devices 

connected on both RF ports will tolerate the DC voltages / currents supplied at the 

respective bias-tee input ports.

SCPI

SYSTem:BIAStee [0|1]
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5.6. Reference Connections

5.7. Trigger In Connection

5.8. Functional Block Diagram

The Ref In & Ref Out ports allow synchronization of measurements with external test 

instruments. The reference source can be switched between the internal and external  

(when connected) sources.

1. Open the reference clock source settings bar

     System → More → Reference Clock Source → Internal | External

2. Select from the Internal or External option

The Trigger In port allows eVNA measurements to be synchronized with external equipment.

Stimulus → Trigger → …

Figure 2 is a functional representation of the eVNA-63+ design, including the source, receiver, 

coupler and bias-tee routing.

SCPI

SENSe:ROSCillator:SOURce [INTernal|EXTernal]

SCPI

TRIGger:…

Figure 2: Functional block diagram of the key eVNA sections

6. Measurement Essentials

6.1. Basic VNA Operation

Figure 3 summarizes the basic elements and signal flows of a generic VNA. Unlike a legacy 

VNA, the eVNA moves the display and the majority of the processing out of the instrument and 

on to an external host PC, with the eVNA Studio software package. This simplifies and reduces 

the cost of the VNA instrument and reduces the risk of obsolescence from an integrated PC 

within a legacy VNA.

The basic components are:

• Source

    Signal generator capable of swept or stepped frequency

• Test Set / Signal Separation

    Separates incident and reflected waves

    Measures incident signal to use as the reference

• Receivers

    Measure real / imaginary data pairs for each measurement

    Can be thought of as small VSA (vector signal analyzers) sharing 

    a common LO (local oscillator)

• Processor

    Performs the required number crunching

    Can be an internal processor or external PC

• Display

    Screen and user interface

Figure 3: Basic elements of a VNA 
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6.2. Transmission & Reflection Measurements

Vector network analysis measurement are based on ratios of transmitted and reflected signals, 

as described in figure 4.

These ratio measurements can be analyzed and presented as a number of metrics:

Incident (R)=Reflected (A)+Transmitted(B)

Transmission Coefficient=T=B/R

Reflection Coefficient=Γ=A/R

Figure 4: Transmitted & reflected signal paths in VNA measurements 

6.3. S-Parameters

S-parameters (scattering parameters) describe the reflections and transmissions within 

a network as complex ratios. They are one of the more widely used set of measurement 

parameters for characterization of RF & microwave devices for linear / steady-state operation.  

The signal flows for s-parameter measurement of a 2-port device with a 2-port VNA are 

summarized in figure 5.

The signal relationships for a 2-port device are described by:

Figure 5: Signal flows in the forward and reverse directions within a 2-port network
Reflection Coefficient (Γ) Transmission Coefficient (Γ)

S-parameters (S11, S22) S-parameters (S12, S21)

Standing Wave Ratio (SWR) Gain, Loss

Gain, Loss Insertion Phase

Impedance, Admittance Group Delay

Reflections = A= Reflected Transmissions = B = Transmitted
R    Incident R     Reflected

Forward Direction
Input return loss

S11 = A

S21 = B

S12 = B

S22 = A

R

R

R

R

Forward insertion loss / gain

Reverse insertion loss / gain Output return loss
Reverse Direction
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C - Practice

Accurate and reliable VNA measurements are reliant on a well-designed test setup. For any 

measurement, a VNA needs to be properly calibrated, with careful consideration given to the 

external accessories and connectors used, including:

• High quality RF cables from ports 1 and 2

• High quality connector adapters if required for connection to the DUT

• Torque wrench to achieve proper mating on all VNA, cable, adapter and DUT connections

Note: 

• To ensure reliable measurements, cables and connector adapters should be regularly inspected for 

damage and discarded in the event of any deficiency.

Mini-Circuits provides a complete set of components, accessories, and tools to support any 

RF and microwave test application. Our full range of catalog components is available from our 

website but a list of carefully selected accessories is summarized below, recommended for use 

with the eVNA.

1. Accessories

Figure 6: 2-port DUT connected with 1 cable - Ensure a connector saver is used on port 2

1.1. Connectors, Connector Savers & Connector Care

It is important to select accessories and cables to match the connector types and genders 

of the DUT. This may require opposite connector types being presented from the port 1 and 

port 2 test cables where the DUT has “in-line” connectors (for example male input and female 

output, or vice versa). All accessories required to connect the DUT must be used during the 

calibration steps, with the swapping of DUT and calibration standards being the only changes 

in the setup.

To avoid wear out or damage to the precision RF connectors on the eVNA front panel, it is 

recommended to use “connector savers” where a device that needs frequent connections / 

disconnections would otherwise be connected directly to the eVNA. A connector saver for  

the eVNA is just an adapter with N-type male input and a convenient output connector type  

for the measurement. This can be left attached to the eVNA and should be discarded in the 

event of any damage. An example use for the connector saver would be between port 2 and 

the DUT in figure 6.

For more information, see the application note at:

https://blog.minicircuits.com/a-simple-trick-to-protect-your-high-frequency-vna-and-save-on-

lab-expenses/

It is important to regularly inspect all connectors used in VNA measurements and discard  

any worn cables or adapters at the first sign of damage.

Torque wrenches should always be used to ensure a good mate between any accessories  

and the eVNA. If the connection is too loose then measurement instabilities / inaccuracies  

may be introduced. Over-tightened connections on the other hand risk damage to the  

eVNA instrument.

1.2. Test Cables

An important factor in ensuring accurate, repeatable measurements in RF test applications 

is the stability of performance of the test cable used. In most test environments, cables 

undergo frequent bending during normal use, which can result in changes in phase and other 

performance parameters. Depending on the cable, these changes can be significant enough 

to degrade the accuracy and precision of your measurements. Therefore, it is important to 

consider how bending affects cable phase performance and how a cable is qualified for 

stability of phase versus flexure.

Phase stability is desirable in test cables because it:

• Ensures tight phase tracking with changing temperature, lowering residual errors  

and uncertainties

• Extends the length of time between calibrations by minimizing drift 

In general, phase is affected by the physical length of the cable assembly, the cable bend 

radius, and the cable assembly technique. Cables are typically designed to operate over  

a wide frequency range and minimize attenuation (insertion loss). 
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The longer the electrical length, the greater the loss.  Since electrical length (and loss) is 

directly proportional to the square root of Ɛr, the dielectric of the cable material, most RF 

cables are manufactured from materials with a low dielectric constant, usually PTFE (Teflon) 

and in some cases SiO2. PTFE is more common because it’s easy to bend without damaging, 

while SiO2 is brittle and only suitable for semi-rigid cable assemblies.

All Mini-Circuits’ cables use PTFE, as a good degree of flexibility is needed in most test 

applications. One drawback of the flexible PTFE construction is, of course, the potential  

for phase changes (and other performance changes) due to bending. Bending the cable 

changes the physical length at the point of bend. It may also constrict and loosen the  

dielectric, shielding, and braiding around the center conductor, which can also affect  

the electrical length and result in phase changes.

Consequently, it is important to observe measurement best practice to minimize these  

effects on VNA measurements:

1. Select only high quality, stable RF test cables, such as Mini-Circuits CBL series

2. Discard cables at the first sign of damage (check the cable, connectors, and the joins      

     between cable and connectors)

3. Use the shortest cable runs possible, but not so short that it impedes the following notes

4. Avoid tight bend radii in the cable arrangements (a longer cable with gentle 270° loop is  

     preferable to a very short, sharp cable bend)

5. Arrange the cables in such a way that the DUT and calibration standards can be swapped 

     in and out without significantly altering the cable arrangements

Figures 7 and 8 present typical applications of these notes.

Figure 7: 2-port DUT connected with 2 sharply bent cables  

Figure 8: 2-port DUT connected with 2 longer cables to allow gentle bend 

|   eVNA-63+ USER GUIDE — C - PRACTICE   eVNA-63+ USER GUIDE — C - PRACTICE   |   



  3635

1.3. Recommended Accessories

These selected Mini-Circuits accessories are recommended for best performance with  

the eVNA. A range of connector types are listed to cover any requirements with SMA  

or N-type DUT.

Cables: minicircuits.com/WebStore/Cables.html

Adapters: minicircuits.com/WebStore/adapters.html

Terminations: minicircuits.com/WebStore/terminations.html

Torque Wrenches: minicircuits.com/WebStore/PortableTestAccessories.html

CBL-2FT-NMNM+ N Male to N Male, Precision Test

CBL-2FT-SMNM+ N Male to SMA Male, Precision Test

CBL-2FT-SFNM+ N Male to SMA Female, Precision Test

SF-SM50+ Adapter SMA-M to SMA-F

SM-SM50+ Adapter SMA-M to SMA-M

SF-SF50+ Adapter SMA-F to SMA-F

NF-NM50+ Adapter N-M to N-F

NM-NM50+ Adapter N-M to N-M

NF-NF50+ Adapter N-F to N-F

NF-SF50+ Adapter N-F to SMA-F

NF-SM50+ Adapter N-F to SMA-M

NM-SF50+ Adapter N-M to SMA-F

NM-SM50+ Adapter N-M to SMA-M

ANNE-50+ Termination SMA Male

ANNEF-50+ Termination SMA Female

KARN-50+ Termination N Male

TRQ-516-08 SMA Torque Wrench

TRQ-N34-8 N-Type Torque Wrench 3/4” 8 lb-in

TRQ-N20-8 N-Type Torque Wrench 20mm 8 lb-in

Model Name

Model Name

Model Name

Model Name

Description

Description

Description

Description

2. Hardware Connection

After connecting and powering on the eVNA-63+ instrument hardware it needs to be 

connected to the eVNA Studio GUI on the host PC.

1. Launch the eVNA Studio GUI

2. Find the instrument:

    System → More → Connections

3. If multiple eVNA-63+ instruments are connected to the PC, select the correct unit by serial    

    number and click Connect

4. If no hardware is available then simulator can be selected instead.  

     See section Section C 11. Simulation Mode (page 77) for details.

Figure 9: eVNA Studio connection screen showing all available instruments

SCPI

SYSTEM:DISCOVER?

SYSTEM:CONNECT <name>

SCPI

SYSTem:PRESet:MODE USER

2.1. System Reset

To reset the eVNA system (software and hardware) to its default state, for example to start  

a new measurement configuration from scratch:

System → Preset → OK
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3. Channels & Traces

The eVNA supports up to 16 measurement channels with up to 16 traces per channel.  

Measurement and formatting operations are applied to specific channels and traces so it 

is important to make sure the relevant channel / traces is selected as the active one when 

making settings changes.

3.1. Channels

Whilst all channels have to share physical resources, they can be thought of as completely 

independent measurement setups, analogous to having a separate eVNA for each 

measurement set. Each channel can be configured with different cal sets and stimulus 

settings.

3.1.1. Channel Setup

Additional channels can be added one at a time using the menu. The Status Bar indicates the 

number of available channels and which one is currently active.

Channel / Trace → Channel → Allocate Channel

3.1.2. Active Channel

Most measurement operations and eVNA settings are applied to the active channel. If the 

required channel is included in the current screen display then clicking it will set it as the  

active channel. Alternatively, the channel number can be specified by opening the Active 

channel setting:

Channel / Trace → Channel → Active

The Previous and Next buttons can be used to quickly toggle between available channels  

and set each one as active in turn:

Channel / Trace → Channel → Previous

Channel / Trace → Channel → Next

3.1.3. Channel Display

The eVNA Studio GUI can be configured to show a single channel or multiple channels, 

arranged side by side. The menu presents a list of icons which approximately show the 

number and arrangement of the channels on screen, up to a 4 x 4 grid for all 16 channels 

(select the More button to scroll through the full list of options).

Channel / Trace → Channel → Channel Layout → …

To quickly maximize the current channel to occupy the full screen, select:

Channel / Trace → Channel → Max

Alternatively, the required number of channels can be specified by opening the Num  

Channels setting:

Channel / Trace → Channel → Num Channels

SCPI

DISPlay:CHANnel <number>

DISPlay:CHANnel:ACTivate

SCPI

DISPlay:CHANnel:SPLit <value>

Num Channels 4

Active 5
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3.2. Traces

Within each channel, multiple traces can be configured to display the measured data. Each 

trace is a separate data plot but all are generated from the same data set captured for the 

given channel. Traces within a channel all share the same calibration and stimulus settings  

but can be configured to show different graphs and formats, derived from the same data.

3.2.1. Trace Setup

Additional traces can be added one at a time using the menu. The Status Bar indicates the 

number of available traces and which one is currently active.

Channel / Trace → Trace → Allocate Trace

3.2.3. Trace Display

The ≠≠ GUI can be configured to show multiple traces in the same display, or spread over 

multiple trace displays. The menu presents a list of icons which approximately show the 

number and arrangement of the traces on screen, up to a 4 x 4 grid for all 16 traces (select  

the More button to scroll through the full list of options).

Channel / Trace → Trace → Trace Layout → …

To quickly maximize the current channel to occupy the full screen, select:

Channel / Trace → Trace → Max

4. Frequency & Power Stimulus Settings

The stimulus settings define the frequency and power of the output ports and any parameters 

related to the measurement sweep. During normal operation the sweep output is always active 

but the RF output can be turned off if necessary. To toggle the RF output on or off:

Stimulus → Sweep Setup → Power Menu → RF Out

Alternatively, the required number of traces can be specified by opening the Num Traces 

setting:

Channel / Trace → Trace → Num Traces

3.2.2. Active Trace

Trace configurations (for example setting the measurement type) are applied to the active 

trace. Any trace can be designated as the active one by clicking on its summary text 

in the top-left of the trace display, or by selecting the trace number through the menu:

Channel / Trace → Trace → Active → n

The Previous and Next buttons can be used to quickly toggle between traces and set each  

one as active in turn:

Channel / Trace → Trace → Previous

Channel / Trace → Trace → Next

SCPI

DISPlay:CHANnel:TRACe <number>

DISPlay:CHANnel:TRACe[:STATe] 1

SCPI

DISPlay:SPLit <value>

SCPI

OUTPut[:STATe] <0|1>

Num Traces 5
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4.1. Frequency Sweeps

The eVNA can operate a frequency sweep with linear or logarithmic values plotted. The default 

condition is a linear frequency sweep. To configure a frequency sweep:

1. Set the relevant frequency sweep type:

     Stimulus → Sweep Setup → Sweep Type → Lin Freq | Log Freq

2. Set the frequency sweep range, either in terms of start and stop frequencies, 

     or center and span values

     Stimulus → Start | Stop | Center | Span

4.1.2. Sweep Power Slope

The port power level for the sweep can be set to have a positive slope with frequency 

(specified in dB / GHz). To configure the slope:

1. Specify the slope value

     Stimulus → Sweep Setup → Power Menu → Slope Value

2. Toggle the slope on and off as needed

     Stimulus → Sweep Setup → Power Menu → Slope

3. The current configuration is indicated in the status bar

3. Set the number of discrete measurement points required for the sweep (increasing the   

     number of points increases the resolution of the data but takes longer to complete the    

     measurement)

     Stimulus → Sweep Setup → Sweep Type → Points

4.1.1. Sweep Power Level

The default output power level for the sweep is 0 dBm. This can be adjusted as required for the 

DUT test scenario, for example to improve signal to noise ratio (SNR) by increasing the port 

power level, or to protect a sensitive DUT by remaining within its input power rating.

4. The current sweep settings are displayed in the status bar:

SCPI

SENSe:SWEep:TYPE <LINear|LOGarithmic>

SENSe:FREQuency:STARt <frequency>

SENSe:FREQuency:STOP <frequency>

SENSe:FREQuency:CENTer <frequency>

SENSe:FREQuency:SPAN <frequency>

SENSe:SWEep:POINts <number>

Frequency 300 KHz

Power Level 5 dBm

Port 1 power 5 dBm

Start: 300K Hz Stop: 6 GHz Center: 3.00015 GHz Span: 5.9997 GHz

Points 200

Caution:
• Review the power ratings of all devices connected in the test path before selecting an output  

power level

To set the power level for both ports to the same value, open the simultaneous power input 

setting:

Ports 1 & 2 can be uncoupled so that power settings can be applied individually to each port.  

To toggle port coupling on and off:

Stimulus → Sweep Setup → Power Menu → Port Couple

To set the power level for an individual port, open the power input setting for that port:    

Stimulus → Sweep Setup → Power Menu → Port Power → Port 1 Power | Port 2 Power

Power Level: 5 dBm Port Couple: No

Note:

• If port coupling is enabled then this power setting will be applied to both ports.

SCPI

SOURce:POWer[:LEVel][:IMMediate][:AMPLitude]   //Power on both ports

SOURce:POWer:PORT:COUPle <0|1>     // Uncouple / couple

SOURce:POWer:PORT <1|2>      // Specify port

SOURce:POWer:PORT[:LEVel][:IMMediate][:AMPLitude] <power> // Power on port above

Slope Value 2 dB/GHz

Power Level: 5 dBm Port Couple: No Slope: YesSlope Value: 2dB/GHz
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4.2. Power Sweeps

Setting the stimulus to power sweep mode allows measurement of a DUT response to 

increasing power level, for example to plot the compression point of an amplifier. To configure 

a power sweep:

1. Set the sweep type to power sweep:

     Stimulus → Sweep Setup → Sweep Type → Power

2. Set the fixed frequency for the sweep:

     Stimulus → Sweep Setup → Power Menu → Sweep Frequency

4.3. Segmented Frequency Sweep

Segmented sweeps allow a compromise to be made between data resolution and overall 

sweep time, by setting the measurement points in a sweep to be focussed at the particular 

frequency ranges of the DUT characteristic where the highest resolution is required. The 

sweep for a band pass filter measurement for example, could be configured to have more 

points in the transition regions where a large variation in data is expected, with fewer points  

in the pass band and far into the stop band.

To configure a segmented sweep:

1. Open the segment table

    Stimulus → Sweep Setup → More → Edit Segment Table

2. Set the display mode to specify whether frequency ranges will be entered as start / stop      

     values or center / span values

3. Check any optional fields (IF bandwidth, delay, sweep time, power level, sweep mode)   

     required to configure those parameters individually for each segment. The global sweep   

     settings will be applied for any options left unchecked.

3. Set the power sweep range, either in terms of start and stop power levels, or center 

     and span values

     Stimulus → Start | Stop | Center | Span

4. Set the number of discrete measurement points required for the sweep (increasing the   

     number of points increases the resolution of the data but takes longer to complete the    

     measurement)

5. The current sweep settings are displayed in the status bar:

SCPI

SENSe:SWEep:TYPE POWer

SENSe:FREQuency[:CW|FIXed] <frequency>

SOURce:POWer:STARt <power>

SOURce: POWer:STOP <power>

SOURce:POWer:CENTer <power>

SOURce:POWer:SPAN <power>

SENSe:SWEep:POINts <number>

Sweep Frequency 1 GHz

Power 10 dBm

Start: -32 dBm Stop: 10 dBm Center: -11 dBm Span: 42 dB

Points 200
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4. Enter the frequency range, number of points and any optional parameters required in the table

5. To delete any row, click on it and then use the delete key

6. The segment table can be saved to a CSV file as a back-up and to allow easy recall for future  

     test sessions, click the “Export To…” button and specify the filename. Use the “Import To…”    

     button to recall a previous CSV file.

7. Click Apply, then OK to apply the sweep segment configuration

8. Set the sweep type to segmented

     Stimulus → Sweep Setup → Sweep Type → Segmented

Note:

• Sweep segment frequency ranges must be unique and cannot overlap

SCPI

SENSe:SWEep:TYPE SEGMent

SENSe:SEGMent:DATA <…>  // Array of data values (refer to programming manual)

4.3.1. Linear & Order-Based Trace Display

The segmented sweep trace can be switched between linear and order-based displays.  

The linear display maintains the typical x-axis frequency scale, with gaps in the trace for any 

frequency ranges not included in the segment table. The order-based display shows a single 

continuous trace, with the x-axis divided equally over the total number of measurement point.  

The x-axis is not a continuous scale in order-based mode so no frequency labels are displayed 

but markers can be used to identify key frequencies.

To toggle between linear and order-based displays:

Stimulus → Sweep Setup → More → Segment Display

4.4.2. Sweep Time Period

The eVNA allows a specific time period to be requested for the sweep.  If the requested period is longer 

than the minimum period required (based on the current sweep configuration), the sweep will be slowed 

down to fit the request.  If the time period requested is shorter than the minimum possible period, the 

sweep will run at the fastest speed and the actual time taken will be reported in the status bar.

To request a specific sweep time period:

Stimulus → Sweep Setup → Requested Sweep Time

4.4.1. Fast Sweep Mode

VNA performance is typically a trade-off between best accuracy and fastest measurement 

time. By default, the eVNA is configured in “normal” mode for best measurement accuracy. 

“Faster” mode can be selected to optimize for a faster frequency sweep, at the expense of 

marginally reduced accuracy. 

To toggle between fast and normal sweep modes:

Stimulus → Sweep Setup → More → Sweep Mode

4.4.3. Sweep Delay

An arbitrary time delay can be inserted before a sweep commences to allow for any settling 

time required by the DUT:

Stimulus → Sweep Setup → Sweep Delay

To reset to automatic sweep time period (toggles on and off):

Stimulus → Sweep Setup → Auto Sweep Time

Segment Display Order Based

Sweep Mode Fast

SCPI

DISPlay:CHANnel:X:SPACing <LINear|OBASe>

SCPI

SENSe:SWEep:GENeration < STEPped|FSTepped>  // Normal / fast mode

Requested Sweep Time 2 ms

Requested Sweep Time: 2 ms Actual Sweep Time: 20.1 ms

SCPI

SENSe:SWEep:TIME:AUTO <0|1>

SENSe:SWEep:TIME[:DATA] <time>
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sweep speed and trigger responses.
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4.4.4. Spur Suppression

The eVNA automatically removes certain low-level, narrow band, spurious signals from the 

measurement data to improve measurement quality. These signals are typically generated due 

to spurious interactions between the internal timing functions of the eVNA. For measurement 

of a very narrow band DUT (in the order of 1 kHz) it may be necessary to disable the spur 

suppression to ensure accurate measurements.

To toggle the automatic spur suppression on and off:

Stimulus → Sweep Setup → More → Avoid Spurious

4.5. Sweep Triggers

Measurement sweeps commence in response to a trigger signal. By default, the eVNA is set  

to the internal trigger source in continuous mode, meaning sweeps repeat continuously.

4.5.1. Trigger Source

The eVNA supports 4 trigger sources:

1. Internal – Default mode, sweeps run continuously

2. External – Sweeps are triggered by a TTL signal on the Trig In port

3. Manual – Sweeps are triggered using the Trigger button in the eVNA GUI

4. SCPI – Sweeps are triggered by a SCPI command sent using the API connection
 

To select the trigger source:

Stimulus → Trigger → More → Trigger Source

To initiate a trigger signal in Manual mode:

Stimulus → Trigger → More → Trigger

To insert a fixed time delay in External mode, between an external trigger input being received 

and the sweep commencing (1 second max):

Stimulus → Trigger → More → Ext Trig Delay

Avoid Spurious: No

Exit Trig Delay 15 ps

The trigger scope can be toggled between all channels and the active channel only:

Stimulus → Trigger → More → Trigger Scope

4.5.2. Trigger Mode

The trigger mode controls the sweep repetition in response to a trigger signal, the options are:

1. Continuous – The sweep restarts on the active channel with every trigger signal

2. Hold – Pauses the sweep on the active channel (measurement traces remain static on  

     the display)

3. Single – A single sweep is run for each trigger signal (the trigger mode then switches to Hold)

4. Hold All Channels – Pauses the sweep on all channels

5. Continuous All Channels – The sweep restarts on all channels with every trigger signal

The trigger mode options are selected at:

Stimulus → Trigger → …

The default behaviour is for a complete sweep to run for each trigger signal. Alternatively, the  

trigger can be toggled to point mode, where each trigger signal initiates a single measurement.  

To toggle between sweep and point triggers:

Stimulus → Trigger → More → Point Trigger

The current sweep can be aborted with:

Trigger Scope Active

SCPI

TRIGger:[SEQuence]:SOURce <INTernal|EXTernal|MANual|BUS>

TRIGger:[SEQuence][:IMMediate]   // Initiate trigger (manual mode)

TRIGger:EXTernal:DELay <time>

TRIGger:[SEQuence]:SCOPe <ALL|ACTive>

SCPI

SENSe:SWEep:DELay

Sweep Delay 1 sec
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5. Measurement & Data Formatting 

5.1. Measurement Types

The eVNA supports a number of measurement types, as summarized in table 3. Full 2-port, 

2-path s-parameter measurements are available (S11, S12, S21, S22) as well as the absolute 

signal levels at each receiver.

These measurement types can be specified using:

Response → Measure → …

S11
S-parameter measurement (reflected / incident at port 1).

Typically, input return loss for a 1-port device.

S21
S-parameter measurement (transmitted at port 2 / incident at port 1).

Typically, forward loss for a 2-port device.

S12
S-parameter measurement (transmitted at port 1 / incident at port 2).

Typically, reverse loss / isolation for a 2-port device.

S22
S-parameter measurement (reflected / incident at port 2).

Typically, output return loss for a 2-port device (or input return loss for a 1-port device on port 2).

Absolute → A1 Absolute signal level at port 1, when sourced from port 1

Absolute → A2 Absolute signal level at port 1, when sourced from port 2

Absolute → B1 Absolute signal level at port 2, when sourced from port 1

Absolute → B2 Absolute signal level at port 2, when sourced from port 1

Absolute → R11 Absolute reference level at port 1, when sourced from port 1

Absolute → R12 Absolute reference level at port 1, when sourced from port 2

Absolute → R21 Absolute reference level at port 2, when sourced from port 1

Absolute → R22 Absolute reference level at port 2, when sourced from port 1

Measurement Type Description

SCPI

CALCulate:PARameter:DEFine S11|S21|S12|S22|A|B|R1|R2 // Set measurement

CALCulate:PARameter:SPORt 1|2     // Set source port

5.2. Graph Types

Graphical displays can be configured in a range of formats to suit the measurement type, as 

summarized in the following sections. Where applicable, the preferred phase unit can be set 

between degrees or radians:

1. Open the phase units setting:

     Response → Format → More → Phase Units

2. Specify the required units:

     Response → Format → More → Phase Units

5.2.1. X-Y Plots

The eVNA supports the data formats summarized in table 4, on a standard rectangular x-y plot.  

Measurement results are plotted on the y-axis against stimulus values (typically frequency) on 

the x-axis.

Each of these options can be set using:

Response → Format → …

Log Mag Logarithmic magnitude (dB)

Lin Mag Linear magnitude

Real Real component

Imaginary Imaginary component

Phase (Deg) Phase (degrees), “wrapped” to appear on a 1 cycle, ±180 degrees scale

Phase (Rad) Phase (radians), “wrapped” to appear on a 1 cycle, ±π radians scale

Positive Phase Phase (degrees or radians), “wrapped” to appear on a 1 cycle, 0 to 360 degrees or 0 to 2π radians scale

Expanded Phase Expanded / continuous / “unwrapped” phase, presents a clear view of phase linearity

Group Delay Group delay (seconds)

SWR Standing wave ratio

Format Description

Table 3: Summary of measurement types supported by the eVNA
Table 4: Rectangular plot data options

SCPI

CALCulate[:SELected]:FORMat MLOG|MLIN|PHASe|GDELay|UPHase|PPHase|SWR|REAL|IMAGinary

CALCulate[:SELected]:PHASe DEGrees|RADians   // Set phase if required

SCPI

INITiate:CONTinuous <1|0>  // Internal / Continuous (1) or Manual / Hold (0)

TRIGger:[SEQuence]:POINt <0|1>

ABORt

Stimulus → Trigger → More → Abort
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Lin / Phase Markers summarize linear magnitude and phase (degrees or radians)

Log / Phase Markers summarize dB magnitude and phase (degrees or radians)

Real / Imag Markers summarize real and imaginary values

5.2.2. Polar Plots

Polar plots are available to display complex magnitude and phase data, as shown in 

figure 10. The magnitude of the measured data is the radial distance from the reference 

point at the center of the diagram. The phase angle is measured counter-clockwise from 

the reference axis (indicated as 0 degrees on the plot). Since polar plots do not include a 

frequency parameter, markers can be used to indicate significant frequencies and data.  

Table 5 summarizes the marker data options for the polar plot.

To enable the polar plot and specify the marker data:

Response → Format → More → Polar → …

SCPI

CALCulate:PARameter:DEFine S11|S21|S12|S22|A|B|R1|R2  // Set measurement

CALCulate:PARameter:SPORt 1|2     // Set source port

5.2.3. Smith Charts

The Smith chart is plotted on the complex reflection coefficient plane and scaled in normalized 

impedances. Similar to the polar plot, frequencies can be indicated using markers since there 

is no frequency parameter on the Smith chart. Table 6 summarizes the marker data options for 

the Smith chart.

To enable the Smith chart and specify the marker data:

Response → Format → More → Smith → …

Lin / Phase Markers summarize linear magnitude and phase (degrees or radians)

Log / Phase Markers summarize dB magnitude and phase (degrees or radians)

Real / Imag Markers summarize real and imaginary values

R + jX Markers summarize resistance and reactance values

G + jB Markers summarize conductance and susceptance values

Format Description

Figure 10: Polar plot representation for a 2.4 GHz BPF S11, with markers set at key frequencies Figure 11: Smith chart representation for a BPF S11, with markers set at key frequencies

Table 5: Polar plot data options Table 6: Smith chart data options

SCPI

CALCulate[:SELected]:FORMat SLINear|SLOGarithmic|SCOMplex|SMITh|SADMittance

CALCulate[:SELected]:PHASe DEGrees|RADians   // Set phase if required

Format Description
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Plotting S11 enables the input impedance of a device to be determined over frequency.  

The closer to the center of the Smith chart the trace is, the closer matched to the 50Ω 

characteristic impedance. The annotated Smith chart of figure 12 summarizes the 

characteristics which can be observed. The impedance only has a real resistive component 

if it lies directly on the x-axis, from 0Ω at the left-hand edge, 50Ω in the center, to infinity on 

the right-hand edge.  If there is an imaginary reactive component to the impedance (either 

capacitive or inductive), the impedance will have an x-axis and y-axis component to it.

2. Specify the electrical delay time required. If delay length is known instead, enter this and the  

     software will automatically calculate and populate the equivalent delay time value. Delay   

     time must be between -10 and +10 seconds.

3. Adjust the velocity factor for the medium as required

4. The media type can also be set between coaxial and waveguide (the cut-off frequency must  

     be specified for waveguide).

5. Click Apply and OK to set the electrical length

5.3. Electrical Delay

A custom electrical delay can be set to shift the phase of the measured data. This feature can 

be useful for observing the deviation from linear phase.

To move the reference place:

1. Select the electrical delay properties

     Response → Scale → More → Electrical Delay

5.4. Scaling

Table x summarizes the options for adjusting the scale on the y-axis. The Auto Scale features 

are convenient for quickly adjusting the graph to fit the current measurement but a number of 

specific customization options are also available.

To access the scale options:

Response → Scale → …

Figure 12: Annotated Smith chart plot

SCPI

CALCulate[:SELected]:CORRection:EDELay:MEDium <COAXial|WAVeguide>

CALCulate[:SELected]:CORRection:EDELay:TIME <value>

CALCulate[:SELected]:CORRection:EDELay:WGCutoff <value>

SCPI

DISPlay:WINDow:TRACe:Y[:SCALe]:AUTO    // Auto Scale

DISPlay:WINDow:Y[:SCALe]:DIVisions    // Divisions

DISPlay:WINDow:TRACe:Y[:SCALe]:PDIVision <value>  // Scale / Div

DISPlay:WINDow:TRACe:Y[:SCALe]:RPOSition <divisions> // Reference Position

DISPlay:WINDow:TRACe:Y[:SCALe]:RLEVEL <value>  // Reference Value

CALCulate[:SELected]:MARKer:SET RLEVel   // Marker → Reference

Auto Scale Automatically adjust the y-axis on the active trace to best present the data

Auto Scale All Automatically adjust the y-axis on all traces to best present the data

Divisions Set the number of divisions / increments on the vertical scale

Scale / Div Set the scale (eg: the number of dB) per division / increment on the y-axis

Reference Position Set the position of the reference line based on number of divisions from the bottom of the trace screen

Reference Value Set the reference line value (the y-axis data value at which the reference line intersects the y-axis)

Marker → Reference
Set the reference line value to the data value indicated by the active marker

Note: requires at least 1 marker to be active on the trace

Scale Option Description
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5.5. Averaging

Averaging provides a means to reduce the fluctuations in measurement traces attributable  

to random noise, allowing a more consistent trace to be presented.

5.5.1. Sweep Averaging

With sweep averaging enabled, each discrete data point in a sweep is calculated as an 

average across a set number of sweeps, therefore minimizing the effect of any random noise 

fluctuations on the data. This enables a trade-off to be made between measurement speed 

and measurement accuracy.

To enable data averaging:

1. Specify the number of sweeps over which measurements should be averaged (from 1 to 999):

    Response → Avg → Factor

5.5.3. IF Bandwidth

IF bandwidth can be adjusted to trade measurement accuracy against measurement speed.  

Narrower bandwidths reduce the incidence of random noise on the measurement, increasing 

the signal to noise ratio. Part of the effect of a narrower IF bandwidth is an increase in data 

sampling for each point in a sweep, therefore slowing down measurement speed. Wider 

bandwidths allow a faster measurement speed but at the expense of noise and therefore 

measurement accuracy.

To set the IF bandwidth (from 1 Hz to 500 kHz):

Response → Avg → IF Bandwidth

5.5.2. Trace Smoothing

Trace smoothing is distinct from sweep averaging. A moving average is calculated from 

consecutive points along a single sweep in order to smooth out sudden variations in signal 

levels. Consequently, measurement speed is faster than the sweep averaging method 

but there can be a significant reduction in measurement accuracy, particularly for higher 

smoothing factors. Trace smoothing is usually not recommended.

To enable trace smoothing:

1. Specify the smoothing aperture (from 1.5 to 25):

    Response → Avg → Smoothing Aperture

2. Toggle smoothing on or off:

     Response → Avg → Smoothing

2 Toggle averaging mode on or off: 

    Response → Avg → Averaging

The averaging can be restarted if required, to clear all saved averages and begin re-calculating, using:

Response → Avg → Restart

SCPI

SENSe:AVERage:COUNt <number>

SENSe:AVERage[:STATe] <0|1>

SENSe:AVERage:CLEar

SCPI

CALCulate[:SELected]:SMOothing:APERture <number>

CALCulate[:SELected]:SMOothing[:STATe] <0|1>

Factor 16

Smoothing Aperture 25

IF Bandwidth kHz10
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6. Markers

6.1. Marker Setup 

Up to 9 markers can be added to each trace at specific frequencies:

1. Select the relevant marker (1 to 9), if the marker doesn’t already exist it will be placed on  

the graph at the sweep center frequency

     Markers / Analysis → Setup → Marker

Markers provide a flexible set of options for highlighting significant data points and statistics, 

performing calculations andsearching for particular signal characteristics. The eVNA supports 

up to 9 markers per trace.

2. The marker frequency can be adjusted by overwriting the frequency in the settings bar

3. To add additional markers or switch between existing markers, select the marker in the  

same way as above

4. Markers will display the frequency and the corresponding data value in the top-left of the 

trace display 

6.2. Moving Markers

Markers can be moved on the trace by editing the frequency input or by clicking and dragging 

the triangular marker indicator on the trace. By default, the markers are in discrete mode so 

will only settle on actual measured frequencies when dragging. Each marker can alternatively 

be set to continuous mode to allow them to be dragged and settle on interpolated frequency 

points between the measured data:

Markers / Analysis → Function → Discrete 

The current marker mode for the active marker is shown in the settings bar:

SCPI

CALCulate [:SELected]: MARKer <number>      // Specify marker number

CALCulate [:SELected]: MARKer: ACTivate      // Set as the active marker

CALCulate [:SELected]: MARKer: X <stimulus>      // Specify the stimulus value

CALCulate [:SELected]: MARKer [:STATe] <0|1>      // Disable or enable the marker

CALCulate [:SELected]: MARKer: Y?       // Read the marker value

2. The marker frequency can be adjusted by overwriting the frequency in the settings bar

3. To add additional markers or switch between existing markers, select the marker in the  

same way as above

4. Markers will display the frequency and the corresponding data value in the top-left of the 

trace display The current marker mode for the active marker is shown in the settings bar:

Channel /  Trace     Response     Stimulus

Discrete: Continuous     Couple: Yes

SCPI

CALCulate [:SELected]: MARKer: X <stimulus>   // Specify the stimulus value

CALCulate [:SELected]: MARKer: DISCrete <0|1>  // Set continuous/discrete mode
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SCPI

CALCulate [:SELected]: MARKer [:STATe] 0     // Disable the marker

Channel /  Trace     Response     Stimulus

Discrete: Continuous     Couple: Yes

SCPI

CALCulate [:SELected]: MARKer: COUPle <0|1>      // De-couple / couple the marker

6.3. Clear Markers

To remove an individual marker from the trace:

Markers / Analysis → Setup → More → Clear → Marker n

To remove all markers from the trace:

Markers / Analysis → Setup → More → Clear → All Off

6.4. Marker Coupling

TMarkers can be coupled together across multiple traces within a single channel, to allow 

them to be moved simultaneously on the respective traces. A typical example would be a 

configuration with S11 and S21 displayed side by side, coupling the markers together allows 

any change in frequency made to the marker position on the S11 trace to be mirrored on the 

S21 trace.

Only markers with the same number are coupled and coupling is applied independently for 

each marker number. For example:

• Marker 1 on trace 1 will couple to marker 1 on every other trace

• Marker 1 on trace 1 cannot be coupled with marker 2 on any trace

To enable marker coupling:

1. Set up multiple traces

2. Add the required markers on each trace (ensuring markers with the same number are used 

where coupling is required)

3. Select the marker to be coupled (on any of the traces)

     Markers / Analysis → Setup → Marker n

4. Toggle coupling on for that marker

     Markers / Analysis → Function → Couple

5. The Couple setting can be toggled again to disable coupling, with the current status 

displayed in the settings bar

6.5. Reference Marker & Delta Mode

In normal mode each marker displays the frequency to which it is pinned and the 

corresponding y-axis measurement value. In delta mode, the marker displays the delta 

between the measurement value and a reference value. The reference marker readout  

shows the pinned frequency and measurement value, with any delta markers showing the 

delta. Each of markers 1 to 9 can be individually toggled between normal and delta mode  

but only one reference level can be set for all markers. Figure 13 shows an example trace  

with markers in normal mode and figure 14 shows the same trace with the markers set to  

delta mode.

Figure 13: S11 trace with markers 1 & 2 in normal mode Figure 14: S11 trace with markers 1 & 2 in 

delta mode from the reference marker

SCPI

CALCulate [:SELected]: MARKer: REFerence [:STATe] <0|1>       // Disable / enable reference marker

CALCulate [:SELected]: MARKer: ACTivate        // Set as the active marker

CALCulate [:SELected]: MARKer: X <stimulus>        // Specify the stimulus value

CALCulate [:SELected]: MARKer [:STATe] <0|1>       // Disable or enable the marker
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SCPI

CALCulate [:SELected]: MARKer: FUNCtion: DOMain [:STATe] <0|1>  // Entire (0) or arbitrary (1)

CALCulate [:SELected]: MARKer: FUNCtion: DOMain: STARt <value>  // Start for arbitrary range

CALCulate [:SELected]: MARKer: FUNCtion: DOMain: STOP <value>  // Stop for arbitrary range
SCPI

CALCulate [:SELected]: MARKer: SET < STARt | STOP | CENTer | RLEVel | DELay>

SCPI

CALCulate [:SELected]: MARKer: FUNCtion: TRACking

6.6. Scale Axis from Marker Position

Markers can be used to quickly adjust the scaling on the x and y-axis based on the current 

marker position. The scale options are summarized in table below can be accessed using:

Markers / Analysis → Function → …

6.7.2. Search Range

Marker searches can be configured to look across the entire sweep range (default behaviour), 

or within a specific sub-range.

To set the range type:

Markers / Analysis → Search → Search Range → Search Range

Start and stop values must be specified for an arbitrary sweep range:

Markers / Analysis → Search → Search Range → Start | Stop

6.7. Marker Searches

Marker searches allow specific data points and frequencies to be highlighted automatically 

based on characteristics of the measured data.

6.7.1. Marker Tracking

By default, the search is run only at the point of selecting the option from the menu. The 

marker frequency will then remain static even if the measured data subsequently changes.  

Alternatively, marker tracking can be enabled to force the search to run again after each 

measurement sweep.

To toggle marker tracking on / off:

Markers / Analysis → Search → Tracking

Scale Option Description

Marker → Start Set sweep start frequency to the frequency of the active marker

Marker → Stop Set sweep stop frequency to the frequency of the active marker

Marker → Center Set sweep center frequency to the frequency of the active marker, the current span will be maintained

Marker → Reference
Set the reference line value (the y-axis data value at which the reference line intersects the y-axis) to the data 

value of the active marker

Marker → Delay Change the line length at the receiver input to remove the phase slope at the marker position

Tracking: Yes

Search Range Arbitrary Range

Start 2.3 GHz

6.7.3. Search Coupling

Marker searches can be coupled together across multiple traces within a single channel, 

allowing one search to be specified for all traces. Markers with the same number are coupled.

To toggle marker search coupling on and off:

Markers / Analysis → Search → Search Range → Couple

6.7.4. Max / Min Search

Moves the active marker to the frequency of the maximum or minimum data point trace:

Markers / Analysis → Search → Max | Min

6.7.5. Peak Search

To specify the peak polarity (positive, negative or both):

Markers / Analysis → Search → Peak → Peak Polarity

SCPI

CALCulate [:SELected]: MARKer: FUNCtion: DOMain: COUPle <0|1>

Peak Polarity Positive
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6.7.6. Target Search

Target searches allow a specific measurement data value to be found on the trace. To configure 

a target search:

• Set the target value 

    Markers / Analysis → Search → Target → Target Value

• Specify whether the target value should be searched on a positive or negative transition  

(or both)

    Markers / Analysis → Search → Target → Target Transition

• To search the nearest target value to the current marker frequency:

    Markers / Analysis → Search → Target → Target

To search the nearest peak to the current marker frequency:

Markers / Analysis → Search → Peak → Search Peak Left | Search Peak Right

Target Transition Positive

Peak Excursion 3 dB

Peak Excursion 3 dB

Target Value 0 dB

Note:

• The marker will not move if it is already located on a relevant peak

Note:

• The marker will not move if it is already located on a relevant target

The peak excursion value can be adjusted from the default value (3 dB) if required. This is the 

value by which a peak must deviate from the previous crest / trough to be considered a peak.   

A higher value is beneficial with noisy measurement traces to prevent all noise picks appearing 

in the search. To set the excursion value:

Markers / Analysis → Search → Peak → Peak Excursion

6.7.7. Bandwidth Search

The bandwidth search displays the following parameters for a trace, based on the current 

marker position, useful for plotting the pass band of a DUT:

Markers / Analysis → Search → Search Range → Couple

• Center frequency

• Lower frequency cut-off

• Higher frequency cut-off

• Pass bandwidth

• Insertion loss at the marker position

• Q value, calculated as:

• The search can also be run for the next target to the left or right of the current  

marker frequency:

Markers / Analysis → Search → Target → Search Left | Search Right

To enable the bandwidth search for a marker:

1. Set the bandwidth value

     Markers / Analysis → Search → More → Bandwidth Value

Center Frequency

Passband
Q = 

Bandwidth Value 3 dB

|   eVNA-63+ USER GUIDE — C - PRACTICE   eVNA-63+ USER GUIDE — C - PRACTICE   |   



  6665

6.7.8. Notch Search

The notch search displays the following bandwidth parameters for a trace, searching for the 

first notch to the left of the current marker position:

• Center frequency

• Lower frequency cut-off

• Higher frequency cut-off

• Notch bandwidth

• Insertion loss at the marker position

• Q value, calculated as:

To enable the notch search for a marker:

1. Set the notch value

     Markers / Analysis → Search → More → Notch Value

2. Toggle the notch search and marker display on or off

     Markers / Analysis → Search → More → Notch

3. The notch bandwidth values are displayed with the marker in the top-left corner of the trace:

Center Frequency

Passband
Q = 

Notch Value -3 dB
2. Drag the marker or set its stimulus value to the trace section where bandwidth is to  

be analyzed

3. Toggle the bandwidth search and marker display on or off

     Markers / Analysis → Search → Bandwidth

4. The bandwidth values are displayed with the marker in the top-left corner of the trace:

7. Memory Calculations (Memory Math)

To normalize the data:

Display → Memory → Normalize

The current sweep trace can be saved to memory and used as a reference for calculations 

against later sweeps. A common application for this feature is “normalization” of data, where  

the reference trace is divided from the latest measurement in order to plot deviations from  

the reference.

Note:

• This performs two steps in 1 command, first saving the current trace to memory, then 

performing a division from subsequent traces

• All other data memory operation require the trace to be manually saved to memory
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8. Measurement Pass / Fail Tests

To save the current trace to memory:

Display → Memory → “Data → Mem”

The trace display can be configured to show either the current data, the saved data from 

memory, or both:

Display → Memory → Display Content → Data | Mem | Data & Mem | Off

To perform a calculation between the latest data trace and the memory trace, select the 

relevant option as summarized in the table below:

Display → Memory → Data Math → …

1. Toggle the limit test on and off with

     Markers / Analysis → Analysis → Limit Test → Limit Test

2. Open the limit table and specify the begin and end points (stimulus and data value) for each 

test limit, including whether the test is against an upper or lower limit

     Markers / Analysis → Analysis → Limit Test → Limit Table

8.1. Specification Limit Test

The limit test allows a number of frequency bands to be defined with minimum or maximum test 

specifications per band. The limit lines and a clear failure indicator can be displayed on the trace, 

as shown in figure 15.

Data Math Opertaion Summary

Data / Mem Latest measurement data divided by memory trace (point by point).  Same effect as normalizing data

Data * Mem Latest measurement data multiplied point by point with memory trace (point by point).  

Data – Mem Difference between measured data and the memory trace (point by point)

Data + Mem Sum of the measured data and memory trace (point by point)

Off Turn off memory math calculations (any calculated traces will revert to showing current data only)

Figure 15: Trace display showing the limit bands to be tested

3. The limit table can be saved to a CSV file as a back-up and to allow easy recall for future 

test sessions, click the “Export To…” button and specify the filename.  Use the “Import To…” 

button to recall a previous CSV file.

4. Click Apply and OK to load the limit table

5. Toggle the limit line display on and off

     Markers / Analysis → Analysis → Limit Test → Display Limit Line

6. Toggle the Failure notice on and off (when enabled, a prominent “FAIL” label will be 

displayed on the trace when the limit test fails)

     Markers / Analysis → Analysis → Limit Test → Fail Sign

8.2. Ripple Test

The ripple test allows a number of frequency bands to be specified with a maximum ripple 

value per band. The eVNA can be configured to mark-up the trace display with the measured 

ripple value, the ripple bands and a clear failure indicator, as shown in figure 16.
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To configure the ripple test:

1. Toggle the ripple limit test on and off with

     Markers / Analysis → Analysis → Ripple Limit → Ripple Limit Test

2. Open the ripple limit table and specify the begin and end stimulus values for each band to 

test, along with the maximum ripple value allowed for the band

     Markers / Analysis → Analysis → Ripple Limit → Ripple Label Table

3. Check the “Is active” option to enable the test

4. The limit table can be saved to a CSV file as a back-up and to allow easy recall for future 

test sessions, click the “Export To…” button and specify the filename.  Use the “Import To…” 

button to recall a previous CSV file.

5. Click Apply and OK to load the ripple limit table

Figure 16: Trace display showing the ripple bands, 

ripple value and test failure notice

Figure 17: Trace display showing the bandwidth test

6. Toggle the ripple line display on and off (2 horizontal lines highlighting the stimulus band, 

placed on the trace at the mean value within the band, ± ripple limit value)

     Markers / Analysis → Analysis → Ripple Limit → Ripple Lines

7.  Toggle the Failure notice on and off (when enabled, a prominent “FAIL” label will be 

displayed on the trace when the ripple limit test fails)

     Markers / Analysis → Analysis → Ripple Limit → Fail Sign

8. If multiple ripple limit bands have been defined, specify which band should be indicated by 

the marker details

     Markers / Analysis → Analysis → Ripple Limit → Ripple Band

8.3. Bandwidth Test

The bandwidth test identifies the pass band of the trace and compares to specified min / max 

limits. The pass / fail result can be displayed on the trace, as shown in figure 17.

To configure the bandwidth test:

1. Toggle the bandwidth test on and off with

     Markers / Analysis → Analysis → Bandwidth Test → BW Test

2. Set the threshold (dB) used to determine the bandwidth of the trace

     Markers / Analysis → Analysis → Bandwidth Test → Threshold

Threshold 3 dB
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3. Set the minimum and maximum stimulus specification limits for the pass / fail test

     Markers / Analysis → Analysis → Bandwidth Test → Min BW

     Markers / Analysis → Analysis → Bandwidth Test → Max BW

4. Toggle the display of calculated bandwidth on and off

     Markers / Analysis → Analysis → Bandwidth Test → BW Display

5. Toggle the bandwidth trace marker display on and off

     Markers / Analysis → Analysis → Bandwidth Test → BW Marker

6. Toggle the Failure notice on and off (when enabled, a prominent “FAIL” label will be 

displayed on the trace when the limit test fails)

     Markers / Analysis → Analysis → Limit Test → Fail Sign

Min BW 50 MHz

Max BW 70 MHz

9. Window / Display Configuration

The eVNA includes a number of options to customize the graph display and configuration.

9.1. Display Update

By default, the graph display is constantly updating live with new measurement data. Where 

fastest speed is critical and the measurement does not need to be viewed live, the display 

update can be turned off and the trace will pause at its last value. Measurement operations 

continue in the background and the display update can be re-enabled again when needed.

To disable or enable display update, toggle the Update option:

Response → Display → Update

9.2. Main Menu Bar

The main menu bar can at the top of the display can be toggled on and off as shown in figure 16:

Response → Display → Display Menu Bar

Channel /  Trace         Response

eVNA-63+ 3.0.5 simulator

eVNA-63+ 3.0.5 simulator eVNA-63+ 3.0.5 simulator

Invert Color: Normal     Update: Yes

SCPI

DISPlay: ENABle <0|1>

DISPlay: UPDate   // One time display update when updating is disabled

Figure 16: Menu bar visible (left) and hidden (right)

Channel /  Trace     Response     Simulus     System

Display Menu Bar: Yes    Bar Font: 14

Display Menu Bar: No    Bar Font: 14

Figure 17: Channel 1 with title label displayed as “New Measurement Label”

To adjust the menu bar font size:

Response → Display → Bar Font

9.3. Channel Labels

The channel title label can be displayed and edited separately for each active channel visible 

on the display. Figure 17 shows the how the label appears above the top left corner of the 

channel’s trace display.

Channel /  Trace       Response       Simulus       System       Markers

Edit Title Label: New Measurement Label      Display  Display Title: Yes

eVNA-63+ 3.0.5 simulator
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Figure 18: Side by side comparison of normal (left) and inverted (right) color schemes

To show / hide the label:

Response → Display → Labels → Display Title Label

To edit the text for the channel label, open the title input in the settings bar and overwrite the 

label as needed:

Response → Display → Labels → Edit Title Label

9.4. Axis Labels

The x-axis and y-axis labels can be turned on and off on the trace display.

To toggle the graticule label (y-axis):

Response → Display → Labels → Graticule Label

To toggle the x-axis frequency label:

Response → Display → Labels → Display Frequency

9.5. Invert Colors

The default eVNA trace color scheme with black background should be familiar to users of 

legacy VNA instruments. The colour scheme can also be inverted to show the traces on a white 

background, which can be more convenient when printing screenshots. Figure 18 shows the 

comparison between the 2 color schemes.

1. To change the color scheme:

     Response → Display → Update

2. Toggle between Normal and Invert in the Settings bar:

     Markers / Analysis → Analysis → Bandwidth Test → Threshold

SCPI

DISPlay: WINDow: TITLe: DATA <title_text>    // Set the label text

DISPlay: WINDow: TITLe [:STATe] <0|1>     // Hide show the label

SCPI

DISPlay: WINDow: LABel <0|1>

DISPlay: ANNotation: FREQuency [:STATe] <0|1>

Invert Color Normal

SCPI

 DISPlay: IMAGe <NORMal | INVert>

10. Save & Recall Data

10.1. Instrument Settings, Calibration State & Measurement Data

Instrument settings, calibration state and measurement data can all be saved to a file on 

the host PC. All data associated with a measurement is exported, including calibration data, 

match networks, measurement data, parameters, setup, and graphs, with zoom and marker 

information. Any number of configurations can be saved to the file system in this way and then 

recalled to the eVNA in an instant, to save time setting up regular measurement profiles time 

and again.

Note:

• All data saved in this process is specific to the instrument and calibration  

that generated it. It cannot be recalled to another VNA, including to another  

eVNA-63+ instrument.

• Instrument and calibration states may change over time so recalled data may no 

longer be valid.
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10.1.1. Saving State Data

To save the instrument state data:

1. Launch the save file dialog box

     System → Save / Recall → Save

2. Enter a filename and set the file type according to the table below, to specify the content of 

the configuration file.

     Markers / Analysis → Analysis → Bandwidth Test → Threshold

10.1.2. Recalling State Data

Specify the state file to recall with one of the 4 file types above. The GUI will load the 

configuration and update the display as required based on the file type.

System → Save / Recall → Recall

3. The “All Channels and Traces” option is checked by default to save full data to the file.  

This option can be unchecked if data is required only for the active channel and trace.

Content File Type Descirption

State .state Full instrument settings including channel, trace and formatting

State + Calibration .cstate Full instrument settings + the current calibration data / configuration

State + Data .dstate Full instrument settings + the current measurement data

State + Calibration + Data .cdstate
Full instrument settings + the current calibration data / configuration + 

the current measurement data

Table 7: Summary of different data save options and the respective file types

SCPI

MMEMory: STORe: STYPe <STATe | CState | DSTate | CDSTate>

MMEMory: STORe: SALL <1|0>

MMEMory: STORe [:STATe] <path/filename.extension>

SCPI

MMEMory: LOAD [:STATe] <path/filename.extension>

10.2. S-Parameter Data

The eVNA can export s-parameter measurement data in Touchstone format as an s1p or s2p 

file. The full measurement data is included, independent of the current trace settings. To save 

the snp data:

1. Specify the required data format for snp file from the following options:

 a. dB & phase angle

 b. Magnitude & phase angle

 c. Real & Imaginary impedance 

System → Save / Recall → Save SnP → SnP Format

2. Then save the data for the required ports:

 a. 1-port s-parameters (S11) for port 1

 System → Save / Recall → Save SnP → S1P → 1

 b. 1-port s-parameters (S11) for port 2

 System → Save / Recall → Save SnP → S1P → 1

 c. Full 2-port s-parameters (S11, S21, S12, S22)

 System → Save / Recall → Save SnP → S2P

3. You will be prompted to specify a path and filename to create the s1p / s2p file on the  

host PC

SCPI

MMEMory: STORe:SNP:FORMat <MA|DB|RI>

MMEMory: STORe:SNP: NPORTS <1|2>

MMEMory: STORe:SNP: PORTS <1|1,2>

MMEMory: STORe:SNP: TYPE:S1P <1|2> | MMEMory:STORe:SNP:TYPE:S2P <1,2>

MMEMory: STORe:SNP [:DATA] <path/filename.extension>
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10.3. Trace Screenshot

The current trace display can be saved as an image file in .png or .bmp format. The image  

will be exactly as the trace is shown on the GUI, including all visible notations and markers.

Where the GUI has been configured to show multiple separate traces, only the active trace is 

included in the screenshot. To save screenshots of additional traces, click each one in turn to 

set it as the active trace before saving. 

System → Save / Recall → Save Screenshot

10.4. Trace CSV Data

Data from the current trace can be exported as a CSV file.  The data columns will reflect the 

formatting specified in the trace display.  Where the GUI has been configured to show multiple 

separate traces, only the active trace is included in the data. 

System → Save / Recall → Save Trace Data

11. Simulation Mode

Simulation mode is a powerful tool within the eVNA Studio software which enables the user 

to explore a fully operational VNA with no up-front cost, hardware, or even a DUT (device 

under test). Connect to an internal simulator in the same way as you would connect to 

the real hardware and then explore the VNA’s capability around a built-in band pass filter 

measurement. The software also accepts imported Touchstone s-parameter files to allow 

simulated vector network analysis of a wide range of RF components.

1. Explore the full eVNA capability prior to purchase

2. Educate yourself on proper VNA configuration and usage

3. Design and practice measurement sequences in advance of DUT availability

4. Visualize and interact with standard Touchstone s-parameter data files to properly analyze 

new RF component choices 

Mini-Circuits has 1000s of s-parameter files available for download from our website for our 

full range of surface mount components.

11.1. Starting Simulation Mode

The eVNA can export s-parameter measurement data in Touchstone format as an s1p or s2p 

file. The full measurement data is included, independent of the current trace settings. To save 

the snp data:

1. Launch the GUI

2. From the top menu, select System → More → Connections to open the Connection Manager 

with a list of available instruments

3. If no eVNA hardware is detected then simulator will be the only option shown, select it and 

click Connect

4. The software will configure itself as if a real eVNA-63+ instrument is connected, with a 

measurement underway on a band-pass filter, centered at 2.4 GHz
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5. The S11 trace is displayed initially but the full range of VNA capabilities can be  

explored based on this simulation, including different measurements, traces,  

markers and calculations

11.2. Simulation of S-Parameter s2p Files

1. Once simulation mode is running you can use the eVNA Studio software as a tool to 

visualize standard Touchstone s-parameter files for other components

2. The example below uses https://www.minicircuits.com/pages/s-params/XBF-282+_S2P.zip 

to simulate Mini-Circuits’ XBF-282+ reflectionless band pass filter

3. In simulator mode, select System → More → Simulator → Load SnP from the menu

4. The trace for S11 will appear initially

5. To add additional traces, select Channel / Trace → Trace → Num Traces and enter the 

number of traces required in the Settings Bar

Num Traces 2

Marker 1 2.35 GHz

6. Initially all traces will appear on a single graph, with a title for each in the top left-hand 

corner, click on the relevant title to modify a particular trace

7. To show the S21 s-parameter response on the additional trace,  

select Response → Measure → S21

8. To add a marker, select Markers → Setup → Marker 1 and then specify the frequency  

(repeat for additional markers as required)
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10. To separate traces on to separate graph displays, select Channel / Trace → Trace → Trace   

  Layout, then scroll through the icons in the Sub Panel to select an appropriate layout

11. To show 2 graphs side by side select the icon below

12. Select Response → Scale → Auto Scale All to adjust both graphs to an appropriate scale

9. All traces are overlayed on the same graph initially D - Calibrate
1.VNA Error Sources

VNAs are precision test instruments, based on relative measurements made between the 

internal source and receiver. To achieve the specified accuracy, the system must be calibrated 

carefully to correct to minimize the sources of error and remove the effects of all accessories 

(cables, adapters and test fixtures) in the VNA to DUT path.

1.1. Types of Error

VNA measurement error sources typically fall into 3 distinct categories, random, drift  

and systematic.

1.1.1 Random Errors

Random errors are non-repeatable errors in a VNA measurement which can’t be eliminated by 

calibration. Care should be taken to minimize random sources of error in the VNA operating 

environment by employing best measurement practices. This includes:

• Stable temperature and humidity

• Minimize sources of electromagnetic noise (e.g., transmitters, motors, high power devices)

• Use of high-quality components and accessories

• Properly torque all RF connections

• Replace worn or damaged connectors, cables, etc. 

1.1.2 Drift Errors

Drift errors begin to appear in any VNA measurement from the time it is calibrated. One 

of the main sources of drift error is temperature variation since the initial calibration. To 

minimize the effect of these errors it is important to allow the instrument sufficient time to 

warm up before calibrating and then maintain a consistent room temperature (25oC ±5oC 

is recommended). The eVNA-63+ has an operating temperature range specification of 

0oC to +55oC but using the instrument at the extremes of this range is likely to degrade 

measurement accuracy.

Since these errors increase over time from the last calibration, they can be eliminated by 

performing a new calibration.
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1.1.3 Systematic Errors

Systematic errors are errors associated with a VNA measurement system itself. These are 

typically consistent for a given VNA instrument and so can be compensated for by performing 

a user calibration. 

1.2. Correcting for VNA Error Sources

The purpose of user calibration is to minimize the systematic measurement errors associated 

with a VNA test setup. The calibration process requires taking measurements of a known set  

of reference standards to produce a set of error correction factors. These error correction 

factors are stored in the VNA and subtracted from the DUT measurements. The process  

has a dual effect on the measurement data:

1. Remove the effect of any cables and accessories in the test path to set the measurement 

reference place as close as possible to the DUT input / output ports

2. Minimize the systematic and drift errors typical of a VNA test setup

    
The eVNA-63+ calibration process is based on known Short, Open, Load, and Thru (SOLT)    

standards, which must be characterized across the full frequency span required for the  

DUT measurements.

It is important to match the calibration kit to the connector type being used for  

the measurement.

 
1.3. Isolation Considerations

VNA port-to-port crosstalk isolation is a limiting factor when performing high dynamic range 

measurements at high frequencies. Crosstalk is the leakage from one port to another when 

no device is present at either port, and can be corrected for as part of the calibration process.   

This correction is especially useful for a DUT with high loss at some point in the measurement 

band, including SAW filters with high stop band rejection, or switches in the open position.  

It should be performed when the port-to-port isolation requirement is >100 dB across the 

frequency span.

The isolation calibration will contribute noise to the measurement close to the VNA noise 

floor. Setting a low IF bandwidth can help to minimize the noise contribution and improve 

measurement accuracy. 

2.Calibration Theory

2.1. Calibration Process Flow

Any connectors, cables, or adapters connected to a VNA as part of the measurement process 

should be included in the calibration so that the reference plane of the measurement can be 

set at the DUT connectors. The general flow diagram for the process to perform a calibration 

is shown in Figure 19. The loop to connect the next standard and run the calibration sweep 

is repeated for each calibration step required in the software, which varies depending on the 

type of calibration selected (for example Short, Open, Load & Thru on both ports 1 and 2).   

At each stage it is crucial to ensure good connections are made. The software indicates  

which standards and tests are needed at each stage.

Figure 19: Calibration process flow diagram

Ensure Bias-Tee is turned off

System → More → Bias-Tee
Start

EndApply the calibration
Save calibration state

System → Save / recall → Save

Set signal sweep parameters

Stimulus → Start | Stop | Center | Span

Set calibration kit

Response → Cal → Cal kit

Set the calibration type

Response → Cal → Calibration → ...

Connect cables and adapters 
as required for the DUT

Connect the calibration 
standard indicated in 

the software

Run the calibration 
measurement

Is calibration of additional 
standards required?

A full 2 port (12 error term) calibration is recommended for measurement of a DUT with 

high isolation or poor return losses. The Load standard is typically used during the isolation 

calibration but for a highly reactive DUT, such as a filter response in the cut-off region, an  

open or short provides better results.
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2.2. How Often to Calibrate

The frequency of user calibrations depends on the specifics of your test setup, including the 

level of accuracy required and the likelihood of changes in the test setup or environmental 

conditions. As a general rule of thumb, it is recommended to re-calibrate the eVNA for any  

of the following reasons:

1. Per day or session – VNA systems should be re-calibrated at the start of a new day or  

test session

2. After changes in external connections – VNA calibrations apply to the specific set of  

external cables and accessories (excluding the DUT) so the system should be re-calibrated 

after changing any external cables, adapters or accessories up to the DUT interface, even 

when swapping accessories like for like. Changes in cable flexure will also affect system 

performance, so for best accuracy you should consider re-calibrating if the cables have  

been subject to significant movement.

3. After changes in environmental conditions – All RF components / systems are affected by 

their environment so re-calibration may be required if there has been a significant change  

in operating temperature or humidity since the last calibration.

4. Between VNA instruments – Calibrations apply to the specific VNA instrument for which 

they were calculated so a new calibration will be required when setting up on a new VNA.

2.3. Reference Plane

The reference plane for a VNA measurement should be set as close as possible to the 

DUT connectors, after any cable and adapter accessories connected in the test path. This 

is achieved by keeping the accessories in the path during the calibration process, so any 

calibration standards required are connected to those accessories at the same point and with 

the same connector gender as the DUT. Careful consideration must be given to the connector 

types and genders of the DUT to ensure the correct calibration standards are available.

Figure 20: Reference plane location for VNA 

measurements with 2 test cables in path

Reference Plane

3.1. SOLT Calibration

SOLT (Short, Open, Load & Thru) calibrations are ideal for measurement of connectorized 

devices. They involve a set of well-defined standards with an appropriate connector type for 

the DUT. The standards are typically accompanied by a set of definitions which need to be 

incorporated into the software. Mini-Circuits’ KSOLT calibration kits are pre-loaded into the 

software to allow easy selection by the user. Cal kit standards from other suppliers can be 

uploaded as summarized later in this section.

Once the cal kit is defined, the eVNA Studio software walks the user through the process to 

connect each standard and characterize across the sweep frequency range.  The software 

compares the measured response against the pre-defined characteristics and computes a 

correction factor to be applied to all future measurements.

The cal kit for any set of measurements typically includes:

•  SOL (short, open and 50Ω load) of the same connector type as the DUT, these are typically 

supplied as 1 component with 3 separate connectors for the individual standards, or as 3 

separate components

  •  Note: SOL standards with both male and female connectors are required for an    

   “insertable” DUT, with male input and female output connectors (or vice versa)

•  Thru standards

  •  Female to female, male to male, and female to male standards with the same electrical 

      length (commonly referred to as “phase equal” or “swap equal” adapters) are required   

     for measurements of a DUT with the same input and output connector gender 

Depending on the type of measurement to be carried out on the DUT, it may only be necessary 

to use a sub-set of the above SOLT standards. For example, characterization of a 1-port device 

would only require short, open and load standards with a single connector gender, to connect 

to a single port on the eVNA.

3. eVNA Calibration Standards
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3.2. Insertable & Non-Insertable Devices

Insertable devices are those with input and output connectors of opposite genders (male to 

female or female to male) whereas non-insertable devices have input and output connectors  

of the same gender. Typical examples of these are presented in figure 21.

Insertable devices are simpler to connect when a thru calibration is required as the two VNA 

cables can be connected together directly. For a non-insertable device, the two VNA cables 

will have the same outward connector gender so cannot be connected together directly.  In 

this event, a set of phase-equal (or swap-equal) Thru standards is required for calibration and 

measurement, as shown in figure 22.

The additional steps for calibration of a non-insertable device are:

1. Select either the male to male or female to female Thru standard as required to mate to the 

two VNA cables

Figure 21: Examples of non-insertable (left) and insertable (right) devices

Figure 22: Set of phase-equal Thru standards—Male to Male  

is required for the above example

Figure 23: Female to female test cables,  

requiring male to male Thru standard 

Insertable ConnectionNon-Insertable Connection

DUT

Port 2

Port 1

DUT

Port 2

Port 1

2. Use the Thru standard to interconnect the two VNA cables for the thru  

calibration measurement

3. Connect the phase-equal male to female Thru standard on one of the eVNA test cables  

for all other calibration and DUT measurements

4. This ensures the phase length of the Thru standard is compensated for at all stages of  

the measurement

Figure 24: Male to male Thru, used to  

interconnect the two VNA test cables

Figure 25: Male to female Thru connected on test cable 2— 

The same connector genders are now presented to the DUT 

3.2.1. 12-Term Error Model

There are 12 measurement error terms that can be calibrated out using the SOLT (Short, Open, 

Load, Thru) calibration model. All 12 terms need to be characterized for a full 2-port calibration 

but only a subset is required for other calibration types, such as a response, enhanced 

response or 1-port calibration. The complete set of 12 error terms comprises the 6 terms 

below in both the forward and reverse directions:

1. Directivity

2. Port 1 match

3. Port 2 match

4. Transmission tracking

5. Reflection tracking

6. Leakage
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The correction factors are calculated during the calibration process and are subsequently 

applied to the DUT measurements. The calibration standards used to determine these error 

correction factors will be dictated by the type of calibration needed and whether the DUT  

is an insertable (with connectors of opposite genders) or non-insertable (with connectors  

of the same gender) device.

3.3. Automatic / Electronic Calibration (eMCal)

Mini-Circuits is developing an automatic, electronic calibration module (eMCal-63+) which  

will be available at the beginning of 2022. This can be used to replace the multiple mechanical 

SOLT standards with a single 2-port device which is connected between the 2 ports of  

eVNA-63+ at the measurement reference plane (after any cables and accessories in the  

RF path). The device is controlled directly from the eVNA Studio software, interfacing with  

the eMCal via USB. Internally, the eMCal switches through a set of well-defined impedances  

to calibrate the instrument.

• Only 2 connections required, eliminating common sources of user error

• Fast and repeatable process, automated through the software

• Internally temperature stabilized

• Available in a range of connector types

• Calibration constants stored internally and loaded automatically

• Please contact testsolutions@minicircuits.com for more information and to be kept 

informed on availability.

3.4. Selecting a Cal Kit

eVNA Studio is preset with two Mini-Circuits mechanical calibration kits (SMA and N-type) 

plus an ideal calibration response. In addition, 17 slots are available for new calibration kits  

to be defined by the user.

Select Response → Cal → Cal Kit to see the list of defined cal kit options shown in Figure 26.

Figure 26: Cal kit options defined in the eVNA Studio GUI

3.4.1. Mini-Circuits’ KSOLT-63-x Cal Kits

Mini-Circuits’ KSOLT-63 mechanical calibration kits to cover all DUT measurement 

requirements with SMA and N-type connections. These precision cal kits are typically  

available from stock, with all parameters and definitions preloaded in the software.

The available cal kits are:

• KSOLT-63-S+

  • Complete set of calibration standards and torque wrench with SMA connectors

• KSOLT-63-N+ 

 • Complete set of calibration standards and torque wrench with N-type connectors 

Each kit contains the following items with the relevant connector type:

• Short / Open / Load standards (female)

• Short / Open / Load standards (male)

• Through standard (female to male)

• Through standard (male to male)

• Through standard (female to female)

• Torque wrench
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Figure 27: SMA KSOLT-63-S+ kit, including SOL (f & m)  

and Thru (f<>f, f<>m, m<>m) standards

Figure 29: General steps to add or modify a cal kit

Figure 28: N-type KSOLT-63-N+ kit, including SOL (f & m)  

and Thru (f<>f, f<>m, m<>m) standards

3.4.2. Ideal Cal Kit

The “Ideal” option in the Cal Kit menu loads ideal 50Ω parameters for the calibration.  

This option can be used for basic measurements where only an indication of performance  

is required, with no guarantee on accuracy. The ideal option is suitable for a response  

calibration where no calibration kit is required.

3.5. Adding / Modifying Cal Kits

Existing calibration kit definitions can be modified and new definitions can be created through 

the Cal Kit menu by following the general steps summarised in figure 29. User defined cal kits 

are automatically saved and will persist on future use of the eVNA software.

Select a suitable cal kit slot

Response → Cal → Cal Kit →  User n

Name the group / subclass 
and specify the standards 

to be used

Are there additional 
groups to define?

Start
Import the XML file

Response → Cal → Modify Cal kit 

→ Import

End

Define the group of 
cal standards based on 

connector type / gender

Response → Cal → Modify Cal Kit 

→ Specify Subclass → Default n

Label the cal kit 
for easy reference

Response → Cal → Modify Cal kit 

→ Label Kit → new_kit

Select a cal kit 
standard to define

Response → Cal → Modify Cal Kit 

→ Define Standards → Standard n

Name the standard, specify 
the type, then enter the 

parameters or import 
from an s1p data file

Are there additional 
standards (SOLT) to define?

Is an XML definition 
file available?

3.5.1. Select and Name a Cal Kit

The eVNA comes pre-populated with 2 Mini-Circuits calibration kits, an ideal response kit and 

17 blank slots names User 1 to User 17. It is recommended to select a blank User slot for a new 

cal kit definition.

1. Select the cal kit to modify 

Response → Cal → Cal Kit → …

2. Set the name / label for the cal kit 

Response → Cal → Modify Cal Kit → Label Kit → …

1. Select the standard to edit

Response → Cal → Modify Cal Kit → Define Standards → …

3.5.2. Define Cal Kit Standards

The calibration coefficients for each standard can be defined through two methods. One 

method is model-based, using an nth order polynomial equation derived from a set of 

parameters entered by the user. The second method is data-based, where the data required  

to characterize the standard is imported from a Touchstone s1p file. The manufacturer of  

the cal kit should be able to provide either the parameters to be entered manually, or the  

s1p data file to define the standard.

By default, the eVNA contains 21 blank slots named “Standard 0” to “Standard 20”.

SCPI

SENSe: CORRection: COLLect: CKIT <number>

SENSe: CORRection: COLLect: CKIT: LABel <name>

Note:

• If two standards have the same model coefficients (for example the male and female 

broadband loads), it is acceptable to define a single standard to be used in both cases.
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2. Specify the label and type for the individual cal kit standard

3. If the manufacturer has made available a Touchstone s1p data file for the standard, it can  

be imported by clicking the ellipsis button next to the filename

4. If no Touchstone s1p file is available, the coefficients can be entered manually, exactly as 

provided by the manufacturer. 

5. Repeat the above steps for each cal kit standard

SCPI

SENSe: CORRection: COLLect: CKIT: STAN <standard_number>

SENSe: CORRection: COLLect: CKIT: STAN: …

3.5.3. Define Subclasses

After defining cal kit standards, it is important to specify the subclasses / groups to be used 

in each calibration scenario. A subclass is used to specify which set of standards are used for 

a particular DUT connection type and gender configuration. For example, a 1-port DUT with 

male input connector requires a different set of SOL standards from a 1-port DUT with female 

input connector.

By convention, the subclass names should reference the connector types and genders of 

the DUT, rather than the connectors of the cable connecting to the DUT. For example, a 

subclass named “N-F to N-M” would be appropriate for a subclass of standards intended for 

measurement of a 2-port DUT with N-type female input and N-type male output connectors.

SCPI

SENSe: CORRection: COLLect: CKIT: ORDer [:SELect] <subclass_number>

SENSe: CORRection: COLLect: CKIT: ORDer:…

3.5.4. Export / Import of XML Cal Kit Definitions

Cal kit definitions can be exported to an XML file for easy recall in the event of accidental  

user changes, and to speed up transferring cal kits between different instances of the eVNA  

Studio software.

To export the active cal kit:

Response → Cal → Modify Cal Kit → Export → …

To import a cal kit:

1. Specify the path and file name of the XML file 

Response → Cal → Modify Cal Kit → Import → …

2. It is recommended to review the name, standards and subclasses to confirm the details are 

correct, by referring to the sections above

3. Specify which of the previously defined standards will be used for the Open, Short, Load 

and Thru on each of ports 1 and 2, then click Apply to save

By default, 8 subclass slots are available per cal kit (each named “Default”).

To specify the subclass:

1. Select the subclass slot 

Response → Cal → Modify Cal Kit → Specify Subclass → …

2. Label the subclass
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SENSe: CORRection: STATe <0|1>

Channel /  Trace         Response

eVNA-63+ 3.0.5 simulator

Correction: Yes    Cal kit: KSOLT-63-S+

Figure 32: Current error correction  

status indicated in the settings bar

3.6. Enabling Error Correction

Error correction must be enabled in order to apply the specified calibration to the measured 

data. Conversely, error correction can be disabled to view raw uncorrected measurement data. 

Error correction is automatically enabled on completion of a user calibration. To toggle error 

correction on / off:

Response → Cal → Correction

The settings bar will show the latest error correction status, in the top-left corner of the GUI, 

just below the main menu, as shown in figure 32.

3.7. Clearing Calibration Data

To delete stored calibration data and turn off error correction:

Response → Cal → Clear → OK

Note:

• This does not affect stored calibration standards and subclasses

SCPI
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There are a number of calibration methods possible, the choice of which is dictated by the 

goals of the measurement session including the required accuracy and the type of device  

to be measured. Figure 33 presents a flow chart of questions which can be asked to determine 

which calibration process is best for a given measurement requirement. Table x summarizes 

the accuracy, errors and merits of the processes available.

Figure 33: Flow chart for choice of calibration process 

4. Calibration Methods

High Accuracy 
Required

Calibrate with Open 
or Short cal standard

Calibrate with Thru cal standard

Response Calibration

Vector Calibration 1-Port or 2-Port Calibration

Highest accuracy full set of 
S-Parameters required?

Calibrate using full 2-Port 
cal with SOLT or eMCal

Calibrate using Enhanced (1-Path, 
2-Port) cal with SOLT or eMCal

Calibrate using vector 1-Port 
cal with SOLT or eMCal

Table 9: Comparison of calibration methods 

Calibration Type
Standards
Required

Effort / Accuracy Errors Removed Typical Usage

Uncorrected N/A No effort / Not accurate None
Course indication of  

performance

Response (Transmission) T Low effort / Low accuracy Transmission tracking

First pass evaluation with 

frequency response of test 

setup removed (S12 & S21)

Response (Reflection) SO Low effort / Low accuracy Reflection tracking

First pass evaluation with 

frequency response of test 

setup removed (S11 & S22)

EnhancedResponse SOLT
Medium effort / Medium 

accuracy

Directivity, source match, 

transmission & reflection 

tracking

2-port, 1-path measurements

(S11 & S12 or S21 & S22)

1-Port SOL SOL Medium effort / High accuracy
Directivity, source match & 

reflection tracking

Reflection measurements

(S11 or S22)

2-Port SOLT SOLT High effort / High accuracy

Directivity, source & load 

match, reflection & trans-

mission tracking, isolation

Best accuracy; full 2-port / 

2-path s-parameters

(S11, S12, S21 & S22)

Automatic (eMCal) eMCal Low effort / High accuracy

Directivity, source & load 

match, reflection & trans-

mission tracking, isolation

Best accuracy, fastest setup, 

minimal user error risk; full 

2-port / 2-path s-parameters

(S11, S12, S21 & S22)
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4.1. Response Calibration

The response calibration removes only the transmission or reflection tracking error terms so 

cannot provide a high degree of measurement accuracy. This can be performed using the 

Short, Open and Thru from an SOLT cal kit, or with no cal kit standard at all since accuracy  

of the measured data will already be limited. The response cal can be used to obtain a first 

pass indication of the DUT performance, with the frequency response of the fixture / cable 

loss removed.

4.1.1. Thru Response (Transmission Tracking)

The Thru response process is a 2-port calibration using the Thru standard to eliminate the 

transmission tracking error, which effectively removes the cable loss from the measurement.

An isolation calibration can optionally be performed to eliminate isolation errors.removed.

Figure 34: Thru connection for response thru calibration

Caution:

• Ensure the bias-tee outputs are disabled to prevent damage to calibration standards

1. Select a calibration kit 

Response → Cal → Cal Kit → …

2. Specify the Thru calibration type and the source / receiver ports for the measurement:

 a. Port 2 as source, port 1 as response:

 Response → Cal → Calibrate → Response → Response Thru → 1-2 (S12) 

 b. Port 1 as source, port 2 as response

 Response → Cal → Calibrate → Response → Response Thru → 2-1 (S21)

3. Connect the Thru to the port 1 and 2 test cables using a torque wrench, as shown in figure 35

4. Select the correct subclass based on the input / output connectors of the DUT

5. Click the Thru button in the calibration window to run the calibration sweep, a tick symbol  

will appear next to Thru when complete

Figure 35: Load connections for response isolation calibration

6. If an isolation calibration is to also to be run, connect a Load standard using a torque wrench 

on both the port 1 and port 2 cables, as shown in figure 35
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7. Click the Isolation button on the calibration window to run the sweep, a tick will appear next  

to the button when complete

8. Click Apply and then Close to complete the process and apply the calibration coefficients  

to the measured data

9. Save the instrument and calibration state so it can be recalled later if needed  

(enter a filename and select the .cstate file type)

 System → Save / Recall → Save

After the full calibration has been completed, it is possible to repeat the calibration  

measurement for an individual standard if needed. Follow the steps above but measure  

only the standard which needs to be updated, then click the Overwrite button to  

complete, instead of Apply. Figure 36: Open connection for response reflection calibration 
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4.1.2. Open / Short Response (Reflection Tracking)

The Open / Short response process is a 1-port calibration (carried out on either port) using 

either the Open or Short standards to eliminate the reflection tracking error.

An isolation calibration can optionally be performed to eliminate isolation errors.

1. Select a calibration kit

 Response → Cal → Cal Kit → …

2. Specify the Open or Short calibration type and the port for the measurement

 Response → Cal → Calibrate → Response → Open | Short → Port 1 | Port 2

To perform the Open / Short response calibration:

Caution:

• Ensure the bias-tee outputs are disabled to prevent damage to calibration standards
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3. Connect the Open or Short on the cable from the specified port using a torque wrench,  

as shown in figure 36

4. Select the correct subclass based on the input / output connectors of the DUT

5. Click the Open button in the calibration window to run the calibration sweep, a tick symbol 

will appear next to Open when complete

6. If an isolation calibration is to also to be run, connect a Load standard on both the port 1 and 

port 2 cables using a torque wrench, as shown in figure 37

7. Click the Load button on the calibration window to run the sweep, a tick will appear next  

to the button when complete

8. Click Apply and then Close to complete the process and apply the calibration coefficients  

to the measured data

9. Save the instrument and calibration state so it can be recalled later if needed  

(enter a filename and select the .cstate file type)

 System → Save / Recall → Save

Figure 37: Load connection for response isolation calibration

After the full calibration has been completed, it is possible to repeat the calibration 

measurement for an individual standard if needed. Follow the steps above but measure only 

the standard which needs to be updated, then click the Overwrite button to complete, instead 

of Apply.
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4.2. Enhanced Response Calibration

The enhanced response process is a 2-port, 1-path calibration using all the SOLT standards.  

This calibration eliminates the directivity, source match, reflection tracking, transmission 

tracking and crosstalk errors.

An isolation calibration can optionally be performed to eliminate isolation errors.

Figure 38: Open / Short / Load connections for enhanced response calibration on port 1 
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Figure 39: Thru connection for enhanced response calibration

Figure 40: Load connections for enhanced response isolation calibration

Caution:

• Ensure the bias-tee outputs are disabled to prevent damage to calibration standards

1. Select a calibration kit

 Response → Cal → Cal Kit → …

2. Specify the Open or Short calibration type and the port for the measurement:

  a. Port 2 as source, port 1 as response

  Response → Cal → Calibrate → Enhanced Response → 1-2 (S12)

  b. Port 1 as source, port 2 as response

  Response → Cal → Calibrate → Enhanced Response → 2-1 (S21)

3. Connect the Open standard on the source port cable as shown in figure 38, using a  

torque wrench

 Response → Cal → Cal Kit → …

4. Click the Open button in the calibration window to run the calibration sweep, a tick  

symbol will appear next to Open when complete

5. Repeat for the Short and Load standards

6. Connect the Thru between the port 1 and port 2 test cables using a torque wrench, as 

shown in figure 39

7.  Click the Thru button in the calibration window to run the calibration sweep, a tick symbol 

will appear next to Thru when complete

8. If an isolation calibration is to also to be run, connect a Load standard on both the port 1 

and port 2 cables using a torque wrench, as shown in figure 40
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9. Click the Isolation button on the calibration window to run the sweep, a tick will appear next  

to the button when complete

10. Click Apply and the Close to complete the process and apply the calibration coefficients to    

   the measured data

11. Save the instrument and calibration state so it can be recalled later if needed (enter a   

   filename and select the .cstate file type)

    System → Save / Recall → Save

After the full calibration has been completed, it is possible to repeat the calibration measurement 

for an individual standard if needed. Follow the steps above but measure only the standard 

which needs to be updated, then click the Overwrite button to complete, instead of Apply.

SCPI

:SYSTem: BIAStee 0

SENSe: CORRection: COLLect:CKIT <number>

SENSe: CORRection: COEFficient: METHod: ERESponse <1,2|2,1>

SENSe: CORRection: COLLect [:ACQuire]: OPEN <1|2>

SENSe: CORRection: COLLect [:ACQuire]: SHORt <1|2>

SENSe:CORRection: COLLect [:ACQuire]: LOAD <1|2>

SENSe: CORRection: COLLect [:ACQuire]: THRU <1,2|2,1>

SENSe: CORRection: COLLect [:ACQuire]: ISOLation <1,2|2,1>

SENSe: CORRection: COEFficient: SAVE

4.3. One Port Calibration

1-port calibration is performed to measure single terminal DUTs such as antennas, only 

the Short, Open, and Load standards are needed from the SOLT kit. Figure 41 shows the 

calibration measurement setup with the eVNA, SOLT standards and accessory cables. 

Including the cables and accessories in the calibration enables the reference plane to be  

set at the DUT connector.

1. Select a calibration kit

 Response → Cal → Cal Kit → …

2. Specify the 1-port SOL calibration type and the port for the measurement:

 Response → Cal → Calibrate → 1-port SOL → Port 1 | Port 2

To perform the 1-port calibration:

Figure 41: Measurement setup for 1-port calibration

Caution:

• Ensure the bias-tee outputs are disabled to prevent damage to calibration standards
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3. Connect the Open standard on the source port cable as shown in figure 41, using  

a torque wrench 

4. Click the Open button in the calibration window to run the calibration sweep, a tick symbol 

will appear next to Open when complete

5. Repeat for the Short and Load standards

6. Click Apply and then Close to complete the process and apply the calibration coefficients  

to the measured data

7. Save the instrument and calibration state so it can be recalled later if needed  

(enter a filename and select the .cstate file type)

 System → Save / Recall → Save

After the full calibration has been completed, it is possible to repeat the calibration measurement 

for an individual standard if needed. Follow the steps above but measure only the standard 

which needs to be updated, then click the Overwrite button to complete, instead of Apply.
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4.4. Two Port Calibration

The full 2-port calibration is the recommended approach where best accuracy is required, 

although it is the most time consuming. It requires the full SOLT calibration kit and the user 

must select the proper accessories based on the connector types of the DUT, considering 

whether it is an insertable (with connectors of opposite genders) or non-insertable (with 

connectors of the same gender) device. An example of the measurement connections to 

perform a 2-port calibration is shown in figure 42 & 43.

Figure 42: Open, Short & Load must be connected in turn on ports 1 & 2

Figure 43: Connect Thru between ports 1 & 2
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To perform the 2-port calibration:

1. Select a calibration kit

 Response → Cal → Cal Kit → …

2. Specify the 2-port SOLT calibration type:

 Response → Cal → Calibrate → 2-port SOLT

Caution:

• Ensure the bias-tee outputs are disabled to prevent damage to calibration standards

3. Connect the Open standard on the port 1 cable as shown in figure 42, using a torque wrench

4. Click the Port 1 - Open button in the calibration window to run the calibration sweep, a tick 

symbol will appear next to Open when complete

5. Repeat for the Short and Load standards on port 1

6. Repeat the process for all 3 standards (Open, Short and Load) on port 2

7. Connect the Thru standard between the cables on port 1 and 2 using a torque wrench,  

as shown in figure 43

8. Click the Thru button in the calibration window to run the calibration sweep, a tick symbol  

will appear next to Thru when complete

9. Connect Loads on both the port 1 and port 2 cables using a torque wrench, as shown in  

figure 42

10. Click the Isolation button in the calibration window to run the calibration sweep, a tick  

   symbol will appear next to Isolation when complete

11. Click Apply and then Close to complete the process and apply the calibration coefficients  

   to the measured data

12. Save the instrument and calibration state so it can be recalled later if needed  

   (enter a filename and select the .cstate file type)

    System → Save / Recall → Save

After the full calibration has been completed, it is possible to repeat the calibration measurement 

for an individual standard if needed. Follow the steps above but measure only the standard which 

needs to be updated, then click the Overwrite button to complete, instead of Apply.
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There are a number of simple settings which can be applied to improve the accuracy of 

calibration measurements, typically at the expense of measurement speed:

Reduce the IF bandwidth:

Response → Avg → IF Bandwidth

5.Optimizing Calibration Conditions
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Enable averaging during the calibration measurements to minimize random errors:

3. Specify the number of sweeps over which measurements should be averaged:

Response → Avg → Factor

4. Toggle averaging mode on:

Response → Avg → Averaging

IF Bandwidth

Power Level

Factor

10

-5

16

kHz

dBm

6.1. Smith Chart Analysis

The Smith chart plot can be used to verify the quality of an Open / Short / Load calibration 

measurement. Before performing the calibration measurements, set the trace format to Smith 

chart and the measurement to S11. The closer to the center of the Smith chart the frequency 

trace is, the closer matched to the 50Ω characteristic impedance. Figures 44 shows the Smith 

chart plots for the Short, Open and Load standards. All standards should appear close to the 

x-axis with the Short on the left-hand edge at 0Ω, the Load on the center at 50Ω and the Open 

on the right-hand edge at infinite impedance. Since the calibration standards are not ideal,  

a resistive arc will typically appear for the Short and a capacitive arc for the Open.

6. Calibration Verification

Figure 44: Smith chart representation of Short, Open & Load standards
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6.2. Golden DUT

One method for verifying whether the last VNA calibration is valid is through the use of a 

golden DUT. The DUT can be any reliable 2 port device, such as a band pass filter. After a  

full calibration, the golden DUT can be characterized to obtain and save a reference set of 

measurement data. To re-confirm the accuracy of the VNA and calibration later, the golden 

DUT can be measured again and the data compared to the original saved data. Any 

differences in the data tend to indicate drift errors which have appeared over time  

since the last calibration, or deviations in the test setup.

7.1. Power Calibration

The eVNA supports power calibration of ports 1 and 2 independently with an external power 

meter. The settings can be found under:

Response → Cal → More → Power Calibration → Port n → …

7.2. Receiver Calibration

A receiver calibration can be performed on ports 1 and 2 for measurements requiring an 

accurate output power level. The settings are under:

Response → Cal → More → Receiver Calibration → …

7.3. Cal Trig Source

External or software trigger synchronisation can be enabled for calibration measurements by 

setting the calibration trigger source to “System”. In this mode the calibration measurements 

will respond to the trigger setting defined for measurements. In “Internal” trigger mode, 

calibration measurements do not wait for an external trigger input.

To toggle between “System” and “Internal” trigger calibration modes:

Response → Cal → More → Cal Trig Source

7. Additional Calibration Options
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Figure 45 presents the measurement data process flow diagram for the eVNA. This summarizes 

the steps taken automatically by the eVNA from measurement to display and is a means to 

understanding where each level of data correction and manipulation is applied.

1.Measurement Process Flow

Figure 45: Data process flow diagram for eVNA measurements

E - Measure
Several examples in this section will be used to present the procedure for typical active and 

passive device measurements. The Calibration section of this guide should be followed to 

calibrate for the test setups in advance of the measurements.

2.1. One Port Device Measurement  (Antenna Example)

The measurement of a 2.4 GHz WiFi antenna will be used as an example of a passive 1-port 

device measurement.

Prepare

Define the measurement data required and familiarize yourself with the relevant eVNA  

settings. Based on the expected characteristics of the DUT, consider the required sweep 

frequency range, power level and number of measurement points required.

1. Return the eVNA-63+ to its default state:

 System → Preset → OK

2. Set the frequency sweep parameters as required:

 Stimulus → Start → 500 kHz

 Stimulus → Stop → 6000 MHz

3. Set the sweep power level:

 Stimulus → Sweep Setup → Power Menu → Power Level → 0 dBm

4. Set the number of points to include in the frequency sweep:

 Stimulus → Sweep Setup → Points → 401

5. Set the IF bandwidth:

 Response → Avg → IF bandwidth → 100 kHz

2. Measurement Examples:

SCPI

SYSTem: PRESet: MODE USER

SENSe: FREQuency: STARt 500000

SENSe: FREQuency: STOP 6000000000

SOURce: POWer 0

SENSe: SWEep: POINts 401
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Practice

Select the appropriate cables and adapter based on the gender of the antenna connector.

Allow the eVNA-63+ sufficient time to warm up.

Calibrate

Carry out the calibration using the 1-port SOL method on port 1, with the correct calibration  

kit selected. Refer to section C-4.3 for details.

Measure

1. Connect the DUT to the open end of the cable from port 1

2. Set the trace to display S11 (return loss):

 Response → Measure → S11

3. Add a marker to the trace:

 Markers / Analysis → Setup → Marker 1

4. Use the mouse cursor to drag marker 1 on the trace display to the lowest point on the S11 

plot. This is the point where the antenna returns the least amount of energy to the source 

and therefore where it transmits the most power (resonance).

5. Scale the display to present the graph as clearly as possible

 Response → Scale → Autoscale All

6. Save the data so that it can be recalled later

 System → Save / Recall → Save

2.2. Pair of One Port Device Measurements (Dual Antenna Example)

The 1-port antenna measurement outlined above can be extended with a second 1-port 

antenna connected on port 2. S11 for both antennas can then be plotted simultaneously  

for comparison and analysis of any interaction between the 2 DUT.

Prepare

Complete the steps for the 1-port antenna example above

Practice

Select the appropriate cables and adapter based on the gender of the antenna connector.

Calibrate

Repeat the calibration process for port 2, with a 1-port SOL calibration on port 2.

Measure

1. With the first antenna already connected and displayed on port 1, connect the second 

antenna on port 2

2. Add an additional trace to the display

 Channel / Trace → Trace → Num Traces → 2

3. Select trace 2 and display S22 (input return loss for the DUT on port 2)

 Response → Measure → S22

4. Scale the display

 Response → Scale → Autoscale All

5. Both traces should now be visible on the same graph display  

(trace 1 / S11 for the antenna on port 1 and trace 2 / S22 for the antenna on port 2) 
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2.3. Two Port Passive Device Measurement (Band Pass Filter Example)

The 1-port antenna measurement outlined above can be extended with a second 1-port 

antenna connected on port 2. S11 for both antennas can then be plotted simultaneously  

for comparison and analysis of any interaction between the 2 DUT.

Prepare

Define the measurement data required and familiarize yourself with the relevant eVNA 

settings. Based on the expected characteristics of the DUT, consider the required sweep 

frequency range, power level and number of measurement points required.

1. Return the eVNA-63+ to its default state:

 System → Preset → OK

2. Set the frequency sweep parameters as required:

 Stimulus → Start → 500 kHz

 Stimulus → Stop → 6000 MHz

3. Set the sweep power level:

 Stimulus → Sweep Setup → Power Menu → Power Level → 0 dBm

4. Set the number of points to include in the frequency sweep:

 Stimulus → Sweep Setup → Points → 201

5. Set the IF bandwidth:

 Response → Avg → IF bandwidth → 100 kHz

Practice

Select the appropriate set of cables and adapters based on the gender of the band pass filter 

connectors. Allow the eVNA-63+ sufficient time to warm up.

SCPI

SYSTem: PRESet: MODE USER

SENSe: FREQuency: STARt 500000

SENSe:FREQuency: STOP 6000000000

SOURce: POWer 0

SENSe: SWEep: POINts 201

[IF bandwidth can’t be set with SCPI]

Calibrate

Carry out the calibration using the 2-port SOLT method, with the correct calibration kit selected. 

Refer to section C-4.4 for details.

Measure

1. Connect the DUT into the RF test path using the same configuration of accessory cables  

and adapters used for the calibration

2. Set 2 traces to display S11 and S21 on the same graph:

 Channel / Trace → Trace → Num Traces → 2

3. Trace 1 will default to S11, click trace 2 to make it active and then set it to display S21:

 Response → Measure → S21

4. Add a marker to the trace:

 Markers / Analysis → Setup → Marker 1

5. Set the marker to the center of the pass band response by specifying the frequency or using 

the peak search function:

 Markers / Analysis → Search → Peak → Search Peak

6. Display the filter bandwidth using the bandwidth search function:

 Markers / Analysis → Search → Bandwidth

The marker label will display the bandwidth, center frequency, lower and upper cut-off 

frequencies and the Q of the filter, as shown in Figure 46.

Figure 46: Measured band pass filter S21 response
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De-embedding is the process of removing the contribution of a test fixture from the measured 

DUT results, the goal is to move the reference plane as close to the edge of the DUT as 

possible. This capability can be used to remove the phase length / loss of fixed coaxial 

cables, microstrip lines, or test fixtures from a DUT measurement. Figure 47 shows a possible 

application for this principle, where the calibration was performed with the configuration  

on the right but later in the setup an additional cable is required between the DUT and  

eVNA instrument.

3. De-Embedding Measurement Data

The eVNA supports 3 possible methods of de-embedding, the details of which are covered in 

the respective sections of this guide.

1. Port extension

2. Time domain gating

3. Modify the calibration kit

3.1 Port Extension

Port extension allows the reference plane to be moved from the calibration plane to the DUT 

edges by adjusting for time delay and loss in the test fixturing.

Figure 47: Typical 2-port DUT measurement setup

Figure 48 presents a common application for port extension where characterization 

of a DUT mounted on a test fixture is required. After calibration, the reference plane 

for the eVNA is at the connector edges as shown in figure 49. The DUT is mounted 

on the test fixture after the SMA launch connector and a section of microstrip (middle 

of image). To measure S11 of the DUT itself, the input section of the fixture needs to 

be de-embedded by moving the reference plane from the test cable connector, to the 

DUT input lead.  Using port extensions, it is not required to perform the difficult task 

of creating a separate test fixture without the DUT as a reference measurement. The 

electrical characteristics of the fixture can be de-embedded from the measurement 

mathematically.

1. Open the port extension settings window

 Response → Cal → Port Extension

Figure 48: Desired reference plane location at the DUT input, mounted on an evaluation board

Figure 49: Desired reference plane location at the output of the VNA cable 
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2. Check the “Enable port extension” option

3. Specify the electrical delay time required. If delay length is known instead, enter this and the 

software will automatically calculate and suggest the equivalent delay time value. Delay time 

must be between -10 and +10 seconds.

4. Specify the loss for the test fixture / substrate at DC and 1 to 2 other frequencies if known.  

An equation is applied to extrapolate loss across the sweep range.

5. Adjust the velocity factor for the medium as required  

(table 10 summarizes some typical values)

6. The media type can also be set between coaxial and waveguide  

(the cut-off frequency must be specified for waveguide)

7. Repeat for port 2 if required

8. Click Apply and OK to update the measured data

Dielectric Velocity Factor

Light in a vacuum 1.0

Air line 1.0

Polyethylene 0.66

Foamed polyethylene 0.82

Table 10: Typical dielectrics and their velocity factors

3.2. Time Domain Gating

Time domain gating is another feature of the eVNA which allows the user to de-embed test 

fixtures from the measured data. Data can be mathematically transformed into the time 

domain and a particular portion (based on the electrical length) “gated” from the data. On 

converting back to the frequency domain, the effect of the gated section is removed from  

the data. The gate type can be defined in terms of a notch or bandpass characteristic

3.3. Modify the Cal Kit

The ability to modify calibration kit provides a simplistic method to remove the effect of the 

test set-up from DUT measurements. Calibration kits can be defined to include the effects of 

adapters, coaxial cables, connectors, and other components in the test path. Refer to section 

C-3.5 for details on how to modify the cal kit standards.

Note:

• It is recommended to clearly label cal kits which have been modified in this way, to 

avoid inadvertent use in other measurements where the “de-embedded” items are  

not included.

There are a number of VNA settings which can be altered to optimize the measurement, 

typically as a trade-off between measurement speed and measurement accuracy.

4.1. Number of Sweep Points

Reducing the number of points in the sweep will reduce the sweep time. If the typical 

characteristic of the DUT is known then it may be possible to optimize the number of points  

by using a segmented sweep. The sweep for a band pass filter measurement for example, 

could be configured to have more points in the transition regions where a large variation in 

data is expected, with fewer points in the pass band and far into the stop band.

4.2. Turn off Display Update

Where fastest speed is critical and the measurement does not need to be viewed live, the 

display update can be turned off and the trace will pause at its last value. Measurement 

operations continue in the background and the display update can be re-enabled again  

4.Optimizing Measurement Speed vs Measurement Performance
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when needed. This feature is particularly applicable where the measurement is automated 

via the eVNA API.

4.3. Use a Single Source

Using both sources for eVNA measurements will double the sweep time due to internal source 

switching. Limiting the measurements to those from a single source (for example S11 and S21 

only) therefore allows a faster sweep time.

4.4. IF Bandwidth

IF bandwidth can be adjusted to suit the highest measurement priority. Narrower bandwidths 

reduce the effect of random noise on the measurement, improving measurement accuracy.  

Wider bandwidths allow a faster measurement speed but at the expense of measurement 

accuracy.

4.5. Data Averaging

Data averaging can be enabled to improve measurement accuracy. Each data point is 

calculated as an average across a set number of sweeps, therefore minimizing the effect  

of any random noise fluctuations on the data. The trade-off is against measurement speed  

as multiple sweeps need to be performed for each measurement.

4.6. Sweep Power Level

Increasing the power level of the sweep has the effect of increasing the signal to noise ratio 

(SNR) of the sweep, improving overall measurement accuracy.

Caution:

• Review the power ratings of all devices connected in the test path before selecting an 

output power level
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